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RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK,
DO NOT REMOVE COVER (OR BACK)
NO USER-SERVICEABLE PARTS INSIDE
REFER SERVICING TO QUALIFIED
SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within an equilateral triangle, is intended
to alert the user to the presence of uninsulated “dangerous voltage” within the
product’s enclosure that may be of sufficient magnitude to constitute a risk of electric

shock.

The exclamation point within an equilateral triangle is intended to alert the user to the
presence of important operating and maintenance (servicing) instructions in the litera-

ture accompanying the appliance.

WARNING:

MOISTURE.

CAUTION:

NOTE:

TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS APPLIANCE TO RAIN OR

TO PREVENT ELECTRIC SHOCK DO NOT USE THIS (POLARIZED) PLUG WITH AN EX-
TENSION CORD, RECEPTACLE OR OTHER OUTLET UNLESS THE BLADES CAN BE
FULLY INSERTED TO PREVENT BLADE EXPOSURE.

SINCE THIS PROJECTOR IS PLUGGABLE EQUIPMENT, THE SOCKET-OUTLET SHALL BE
INSTALLED NEAR THE EQUIPMENT AND SHALL BE EASILY ACCESSIBLE.

WARNING

Use the attached specified power-supply cord. If
you use another cord, it may cause interference
with radio and television reception.

Use the attached RGB cable, RS-232C cable with
this equipment so as to keep interference within the
limit of a Class A device.

The projector automatically shuts off
when the lamp is used up in about
1,300 hours and not used until lamp
replacement.

DO NOT LOOK DIRECTLY INTO THE LENS
WHEN PROJECTOR IS IN THE POWER ON
MODE.
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Important safeguards

PLEASE READ ALL THESE INSTRUCTIONS RE-
GARDING YOUR LCD PROJECTOR AND RETAIN
THEM FOR FUTURE REFERENCE. FOLLOW ALL
WARNINGS AND INSTRUCTIONS MARKED ON
THE LCD PROJECTOR.

1.

Read instructions
All the safety and operating instructions should
be read before the appliance is operated.

Retain instructions
The safety and operating instructions should be
retained for future reference.

Warnings
All warnings on the appliance and in the oper-
ating instructions should be adhered to.

Instructions
All operating instructions must be followed.

Cleaning

Unplug this projector from the wall outlet be-
fore cleaning it. Do not use liquid aerosol clean-
ers. Use a damp cloth for cleaning.

Attachments and equipment

Never add any attachments and/or equipment
without the approval of the manufacturer as
such additions may result in the risk of fire, elec-
tric shock or other personal injury.

Water and moisture
Do not use this projector near water or in con-
tact with water.

Accessories

Do not place this projector on an unstable cart,
stand, tripod, bracket or table. Use only with a
cart, stand, tripod bracket, or table recom-
mended by the manufacturer or sold with the
projector. Any mounting of the appliance should
follow the manufacturer's instructions and
should use a mounting accessory recommended
by the manufacturer.

An appliance and cart combination should be
moved with care. Quick stops, excessive force and
uneven surfaces may cause the appliance and
cart combination to overturn.

[\ TN
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Ventilation

Slots and openings in the cabinet are provided
for ventilation, ensuring reliable operation of the
projector and to protect it from overheating. Do
not block these openings or allow them to be
blocked by placing the projector on a bed, sofa,
rug, or bookcase. Ensure that there is adequate
ventilation and that the manufacturer's instruc-
tions have been adhered to.

10.

11.

12.

13.

14.

15.

16.

17.

Power sources

This projector should be operated only from the
type of power source indicated on the marking
label. If you are not sure of the type of power
supplied to your office, consult your appliance
dealer or local power company.

Power-cord protection

Power-supply cords should be routed so that they
are not likely to be walked on or pinched by items
placed upon or against them. Pay particular at-
tention to cords at plugs, convenience receptacles,
and points where they exit from the appliance.

Overloading
Do not overload wall outlets and extension cords
as this can result in a fire or electric shock.

Object and liquid entry

Never push objects of any kind through open-
ings of this projector as they may touch danger-
ous voltage points or short-out parts that could
result in a fire or electric shock. Never spill lig-
uid of any kind on the projector.

Servicing

Do not attempt to service this projector yourself
as opening or removing covers may expose you
to dangerous voltage or other hazards. Refer all
servicing to qualified service personnel.

Damage requiring service

Unplug this projector from the wall outlet and

refer servicing to qualified service personnel un-

der the following conditions:

(a) If the power-supply cord or plug is dam-
aged.

(b) Ifliquid has been spilled, or objects have
fallen into the projector.

(¢) Ifthe projector does not operate normally
after you follow the operating instructions.
Adjust only those controls that are covered
by the operating instructions. An improper
adjustment of other controls may result
in damage and may often require exten-
sive work by a qualified technician to re-
store the projector to its normal operation.

(d) If the projector has been exposed to rain
or water.

(e)  If the projector has been dropped or the
cabinet has been damaged.

(f)  If the projector exhibits a distinct change
in performance - this indicates a need for
service.

Replacement parts

When replacement parts are required, be sure
that the service technician has used replacement
parts specified by the manufacturer or parts
having the same characteristics as the original
part. Unauthorized substitutions may result in
fire, electric shock or other hazards.

Safety check

Upon completion of any service or repair to this
projector, ask the service technician to perform
safety checks determining that the projector is
in a safe operating condition.



WARNING:
Unplug immediately if there is

something wrong with your projector.
Do not operate if smoke, strange noise or odor comes
out of your projector. It might cause fire or electric
shock. In this case, unplug immediately and contact
your dealer.

Never remove the cabinet.

This projector contains high voltage circuitry. An
inadvertent contact may result in an electric shock.
Except as specifically explained in the Owner's
Guide, do not attempt to service this product
yourself. Please contact your dealer when you want
to fix, adjust or inspect the projector.

Do not modify this equipment.
It can lead to fire or electric shock.

If you break or drop the cabinet.

Do not keep using this equipment if you break or
drop it. Unplug the projector and contact your dealer
for inspection. It may lead to fire if you keep using
the equipment.

Do not face a lens to the sun.
It can lead to fire.

Use correct voltage.
If you use incorrect voltage, it can lead to fire.

Do not place the projector on uneven
surface. Level stable surface only.

Please do not place equipment on unstable surfaces.
Do not look into the lens when it is operating. It may
hurt your eyes.

Never let children look into the lens when it is on.

Do not turn off the main power
abruptly or unplug the projector
during operation.

It can lead to lamp breakage, fire, electric shock or
other trouble.

Place of installation

Refrain from setting the projector at any place subjected
to high temperature and high humidity. Precision devices
are built into the projector. Please maintain an operating
temperature, humidity, and altitude as specified below
for safety's sake.

e Operating temperature: between +41°F (+5°C) and

+95°F (+35°C)

Operating humidity: between 30 and 90%

Never put any heat-producing device under the pro-
jector so that the projector does not overheat.

¢ Do not attach the projector to a place that is un-
stable or subject to vibration.

¢ Do not install the projector near any equipment that
produces a strong magnetic field. Also refrain from
installing near the projector any cable carrying a
large current.

e Place the projector on a solid, vibration free sur-
face: otherwise it may fall, causing serious injury
to a child or adult, and serious damage to the prod-
uct.

¢ Do not stand the projector: it may fall, causing se-
rious injury and damage to the projector.

e Place the projector within a slope of £15°. Slanting
the projector more than +15° may cause trouble or
explosion of the lamp.

¢ Do not place the projector near air-conditioning unit
or heater to avoid hot air to the exhaust and venti-
lation hole of the projector.

COMPLIANCE NOTICE OF FCC

the Department of Communications.

ate this equipment.

ment Regulations.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance
with the instruction manual, may cause harmful interference to radio communications. Operation of
this equipment in a residential area is likely to cause harmful interference in which case the user will
be required to correct the interference at his own expense.

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital appara-
tus as set out in the interference-causing equipment standard entitled “Digital Apparatus”, ICES-003 of

Changes or modifications not expressly approved by Mitsubishi could void the user's authority to oper-

COMPLIANCE NOTICE OF INDUSTRY CANADA

This Class [A] digital apparatus meets all requirements of the Canadian Interference-Causing Equip-

ENGLISH
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Overview of the projector

lamp lid

Caution:

Do not replace the lamp right after using the projector. The lamp is

— power indicator

When the main power switch is on in stand-by mode, this indicator lights up red. When the projector

is fully "ON", the indicator lights up green. See page 44.

~—lamp indicator
This informs you of the status of the light source lamp and its service life. When the projector
lamp is lit, the indicator lights up in green. When operation time of the light source lamp has
exceeded 1,000 hours, the indicator will flash alternately between red and green (while the lamp
is in use). When the lamp is exhausted, the indicator will show red only. When the lamp is used
up to 1,300 hours, the projector automatically shuts off. See pages 40 and 44.

— temperature indicator
This informs you of the thermal condition inside the projector. When the inside
temperature is extremely high, the power automatically shuts off while the indicator
blinks red. See page 44.

exhaust slits

handle
Hold here to carry this projector.

remote control sensor (Front/Rear)

release button
Press to adjust the angle of projection. See page 11.

PC card indicator
When the PC card is inserted, these indicators light up. See page 27.

=

b

L%AP T%/IP

CAJgD 1

CA(RJD 2

FOCUS AUTO

menu
Use to project menu display.

fine ( <,> )
Use to make FINE adjustment etc. See the table as shown below.

J

J

—power

very hot. Switch the projector to stand-by mode, wait at least 120
seconds for the lamp and LCD panel to cool. Then turn off the main
power switch, unplug from the outlet and wait for another one hour or
until the lamp is cool to the touch. See page 40.

d) RGB VIDEO CARD MENU r FINE 1 —T— /[ZOOM POSITION}
@ @ — auto position
| 1 1 1 1 i ENTER Use to adjust the position
1 1 1 1 = of Personal computer
) image. See page 16.

- 7 ’ “—focus/zoom
input source Use to change the mode of the adjust
(RGB, VIDEO, CARD) buttons, focus or zoom etc. See the table
Use to select the input as shown below.
source you wish to watch.

N,V

Use to make FOCUS or ZOOM adjustments etc.
See the table as shown below.

Use to turn the projector on or off when MAIN POWER is on. To turn the projector off, press this button twice.

Important:
When the lamp indicator lights up in green, the power switch cannot be used to switch “ON” and “OFF.”
Begin operation only after the indicator has stopped blinking.

FINE, V, /\, FOCUS/ZOOM and AUTO POSITION buttons

The operations of these buttons vary as follows depending on the modes selected:

FINE () FINE (>) \Y4 N\ FOCUS /ZOOM |(AUTO POSITION
. Adjust FOCUS or| Adjust FOCUS or[FOCUS or ZOOM| Adjust position
Normal Adjust FINE (-) | Adjust FINE(+) ZOOM (-) ZOOM (+) setting when incorrect
Select the setting [Select the setting | Set the setting Set the setting | Enter the layer B
On Menu item (Left) item (Right) item item setting
On PC Select previous Select next Select Select Select the Select the
card Menu image (Left) image (Right) INDEX or FILE | INDEX or FILE group (-) group (+)




PC card eject E]H 1

Press to eject the PC card. See page 27.

-- EEEEEEEEEEEE g

®
m-m @ .

PC card insert slot J
This is where you insert the PC card.
See page 27.

) )
[ ]
[ ]
1
PC audio input (stereo mini jack) .
— PC analog RGB input (mini D-SUB 15P) Use to input PC audio signals. See pages ; 5
Use to input RGB signal for PC. See pages 13 - 15. . =
13 - 15. p video/audio input ' %
s =\ Use to input video and ' &)
( INPUT1 | INPUT2 MAIN \ audio- See page 12- :
- e [ sbe [0 MAIN power .
( L&D . . I:O0N :
. l o 4 O : OFF A
==L
RGB OUT
PC analog RGB output }{O o power jack
(mini D-SUB 15P)
Use to output RGB signal from ‘[O L'NE S

RGB1 OR RGB2 input. See pages

13-15. L RS-232 2 input (Mini DIN 8P)
RS-232 1 input (D-SUB 9P) —— Connects to personal computer when using

Connect§ to personal' computer SpacePointer (RGB2 IN). See page 37.
when using SpacePointer (RGB1
IN), accessory PCGC and so on.

See pages 35 and 37.

line output
Use to output PC audio if PC audio in, or
Audio input 1 or 2 is connected. See pages

12 - 15.
PC analog RGB input (Pin assignment of D-SUB 9P)
Use to input video signals (analog [ g PIN NO.|CODE NAME /0 NOTE
RGB) of a personal computer. 15 1 CD Carrier Detect IN |not connected
2 RD | Receive Data (RXD) IN | connected to inner circuit
(Pin assignment of Mini D-SUB 15P jack) 3 SD Send Data (TXD) OUT | connected to inner circuit
PIN NO. SPEC PIN NO. SPEC 4 ER Eqm;’)ment Ready(DTR) | OUT |not connegted _
5 SG Signal Ground connected to inner circuit
1 R(RED)/Cr o - 6 | DR | Data Set Ready(DSR) | OUT |not connected
2 G(GREEN)/Y 10 GROUND 7 RS | Request to Send(RTS) OUT | not connected
3 B(BLUE)/Ce 11 GROUND 8 CS | Clear to Send (CTS) IN [not connected
4 GROUND 12 — 9 RI Ring Indicator IN |not connected
5 GROUND 13 HD/CS
6 GROUND 14 VD . ..
= GROUND 15 — RS-232C 2 input (Mini DIN 8P) i;
8 GROUND e Please use RS-232C crossover gable and MAC sﬁgvﬁis
adaptor for RS-232C cable provided. l!
RS-232C input PIN NO.| CODE NAME 10 NOTE
Connect here when you control this Projector with a 1 RS | Request to Send(RTS) | OUT |not connected

personal computer using PCGC (personal computer
graphic controller) or with a remote controller using
SpacePointer function.

RS-232C 1 input (D-SUB 9P) 1 s
¢ The Pin assignment is DTE (Data Terminal @:ﬂ
Equipment) type. j a—
e Please use RS-232C crossover cable pro-
vided.

CS | Clear to Send (CTS) IN [not connected

SD Send Data (TXD) OUT | connected to inner circuit

SG Signal Ground connected to inner circuit

RD | Receive Data (RXD) IN | connected to inner circuit
- not connected

- not connected

(I || |W [N

— not connected
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Overview of the remote control

operation indicator
When the operation button is
pressed, this indicator blinks. It also
illuminates when the projector is in
the personal computer mode or

drawing mode which is able to have
a cursor operation. See pages 25, 38.

cancel

This operates in the same way as the
right button on the computer mouse.
If this button is pressed during
drawing mode, the figure will
diappear. See pages 25, 38.
start/stop

Use to turn the PC control mode or
cursor operation mode on or off.
See pages 25, 38.

select
This operates in the same way as the
left button on the computer mouse. By
pressing this button during the drawing
mode can set the start and end point of
the figure. See pages 25, 38.

double click
This operates in the same way as
double clicking the left button on the
computer mouse. See pages 25, 38.

¢

. focus / zoom
?II{I()}u]; S‘(f)ill;‘gé) CARD) Use to change FOCUS or ZOOM mode.
’ ’ See 17.
Use to select the input source you wish to STARTISTOP -
AV . <4)

watch. If this button is pressed during PinP
mode, the input signal of sub image will be
changed. See page 16.

menu g
Press to display MENU selection bar.
Exit the menu system by pressing the
MENU button during displaying MENU
display. See page 18.

RGB__ VIDEO  CARD Used for MENU setting. See the
table as shown below.

S

TOCUS .
1ZOOM enter/still

Used for MENU setting. Also, use to
freeze the image. See pages 18 and 25.

volume (+)
j— Press to turn the volume up. See the

table as shown below.

0

0
810108

ENTER
[STILL

volume (-)
Press to turn the volume down. See the
table as shown below.

PinP
Press to turn on the PinP (Picture in
Picture) image, or to cancel it. See page 26.

cursor

Press to display the cursor. Also
PC CARD —— AUTO used to change the mo'de of PC
PLAY RELEASE |PQOSITION control or cursor operation, when
the projector is connected to a
personal computer with RS-232C.
See pages 25 and 38.

(-
auto position

Use to adjust the position of Personal
computer image. See page 16.

PP

Y J =
Og 6 OA Og J
S =

U

7
U
0

[

expand
Use to expand the image. See page 26.

card auto play -
Press to start auto play function of the

PC CARD. See page 28.

VA

power
Use to turn the projector on or off
when MAIN POWER is on. To
turn the projector off, press this
button twice. See page 22.

PC card release
Press this button to be able to eject
PC card. Make sure to press this
button all the time to eject the PC
card. See page 27.

The operations of these buttons varies as follows depending on the modes selected:

< > v A - (VOL) + (VOL)
Adjust FOCUS or| Adjust FOCUS or Volume down Volume u
Normal | Adjust FINE (-) | Adjust FINE(+) ZOOM (-) Z00M (+) P
Select the setting |Select the setting | Set the setting Set the setting B _
On Menu item (Left) item (Right) item item
On PC Select previous Select next Select Select Select the Select the
card Menu image (Left) image (Right) | INDEX or FILE | INDEX or FILE group (-) group (+)

Exchange the image |Exchange the image | Switch still pictures | Switch still pictures | Recapture of the | Recapture of the
PinP (main or sub) (main or sub) (main or sub) (main or sub) still picture still picture

Expand different | Expand different | Expand different | Expand different | Set the expand | Set the expand
EXPAND area (Left) area (Right) area (Down) area (Up) rate (-) rate (+)




Important:

¢ To save battery power, turn off the operation indicator by pressing the START/STOP button when not in use.

e To save battery power, the operation indicator will turn off if the remote control is not operated for a period of
5 minutes.

Battery installation

Use two AA size batteries.

1. Remove the back cover of the remote control by pushing the battery compartment door in the direction of the
arrow.

2. Load the batteries making sure that they are positioned correctly (+ to +, and - to -).

3. Replace the back cover.

ENGLISH

Important:

¢ Do not use a new battery with an old one.

Load batteries in the correct position.

Do not heat, take apart, or throw batteries into fire.

Do not try to recharge batteries. Do not use rechargeable batteries.

If the alkaline solution of alkaline batteries comes in contact with your skin or clothes, rinse with water. If
the solution comes in contact with your eyes, rinse them with water and then consult your doctor.

Operation area
The range for operation is about 10m when the remote points to the projector. When using the remote control for
SpacePointer, the range for operation is about 7m. The distance to the screen back to the projector must be less

— ==

8

Important:
Avoid the direct sunlight or fluorescent light to the remote control sensor. Also keep the distance of more than 2 m
between the remote control sensor and fluorescent lamp. The remote may not work correctly.



ENGLISH

Preparing the projector for operation

Orientation of the projector

Picture size can be set by changing the distance between the screen and the projector.

Front projection

screen

To find the approximate distance
between the projector and screen:
Multiply the width of the screen
x 1.875 ~ 1.975 (max.) ,

Multiply the width of the screen
x 2.468 ~ 2.57 (min.) ,

¢ Refer to the chart to recom-

H teigho) i - - mended distgr}ces in maximum
- L (between the screen and center zoom and minimum zoom.
of the head of the lens-barrel)
Screen Distance from screen (L) / (approximate) Height projected
Maximum Minimum image (H)
Diagonal size | Height inches | Width feet zoom (min.) zoom (max.) / (approximate)

(inch) (inch) (inch) (mm) (inch) (mm) (inch) (mm) (inch)
40" 24" 32" 1527 60.12" 2012 79.21" 76 3.0"
60" 36" 48 " 2335 91.93" 3062 120.55" 114 4.49"
80" 48 " 64" 3143 123.74" 4112 161.89" 152 5.98"
100" 60 " 80" 3951 155.55" 5162 203.23" 191 7.52"
120" 72" 96" 4758 187.32" 6213 244.61" 229 9.02"
140" 84" 112" 5566 219.13" 7263 285.94" 267 10.51"
160 " 96 " 128" 6374 250.94" 8313 327.28" 305 12.0"
180" 108 " 144" 7182 282.75" 9363 368.62" 343 13.5"
200" 120" 160" 7990 314.57" 10413 409.96" 381 15.0"
300" 180 " 240" 12029 473.58" — - 572 22.52"

Front projection, ceiling mount

For ceiling mount, you need the ceiling mount metal

etc. Also ask specialist for installation. For more

detail, ask your dealer.

SCREEN

e When the use of ceiling mount, set IMAGE

REVERSE in INSTALLATION menu to INVERT.

You can not use KEYSTONE when IMAGE
REVERSE is INVERT. See Page 20.

¢ Projected images may appear darker when the

unit is used as a ceiling installation than when it

is used in the tabletop position. This does not
signify a product malfunction.

Rear projection

Also ask specialist for installation. For more detail,

ask your dealer.

SCREEN

10

For rear projection, set IMAGE REVERSE in
INSTALLATION menu to MIRROR. See Page 20.

Caution:

Placing the projector on a carpet reduces ventila-
tion from the fan on the bottom and might cause
problems. Place a hard board or similar item
under the projector to facilitate ventilation of the
unit.

Place the projector more than 20 in. from the wall
to prevent blocking the intake, exhaust slots and
ventilation of this projector because hot air comes
out of it.

Do not use the projector under the following
circumstances, which may cause fire or electric
shock.

¢ in a dusty or humid place

e while the projector is lying sideways or upside
down.

near a heater

in a kitchen or oily, smoky or damp place

in direct sunlight

where the temperature is lower than 41°F or

higher than 95°F

Important:

Do not put stress on the lens or focus ring, as this
may damage them.

Keep your room dark while using the projector. The
image cannot be seen clearly in a bright place.




Adjusting the angle of projection

Screen on a flat wall with a 90 degree angle to the floor
by adjusting two foot adjustments on the bottom of the
projector. If the angle cannot be corrected by them,
adjust the height and angle of screen.

2. Press the release button for angle adjustment to take
the adjustment feet out of the projector.

3. Release the button and keep your hands away from
the projector.

angle.

After using the projection,
5. Press the release button to take the projector down
slowly with holding it.

Important:

The image becomes trapezoid shape when the screen
or project is not level. Use KEYSTONE in ENHANCED
menu to adjust, however, the circumference of the im-
age may not be focused. See page 20.

e Screen on a flat wall with a 90° angle to the floor.

¢ Align projector to produce a full screen display as
illustrated on page 10.

e Distance from projector to screen must be
compatible with screen size chart on page 10. Note
distance from screen chart.

e Ifimage is not square on screen, try adjusting the
front feet of the projector for proper angle.

Getting ready for projection

1. Connect the power cord provided to this projector
with the power jack of the projector.
2. Connect the power cord to the wall outlet.

Plug in the provided
power cord directly.

ground
terminal

3. Take off the lens cap.
4. Do not look directly into the lens when projector is
“ON”.

Warning:

e The lens cap is for protecting the lens. If you leave
the power on with the cap on, the cap may be warped.
Please remove the lens cap when you turn the power
on.

e A three-pin grounding type power plug is used with
the projector. Do not remove the grounding pin on
the power plug. If you are unable to insert the plug
into the outlet, contact your electrician to replace
your obsolete outlet.

e The supplied power cord is used for 120V only. Never
connect to any outlet or power supply having a dif-
ferent voltage or frequency. If you connect to the
power supply having a different voltage, please use
the appropriate power cord.

¢ Do not place an object on the power cord and keep
the projector away from heat source to avoid break-
ing the power cord. A broken of power cord can cause
fire or electric shock.

¢ Do not revise or alter the power cord otherwise it
may cause fire or electric shock.

Contact your dealer if the cord is broken.

Caution:

¢ Plug in firmly and unplug by holding the plug, not
by pulling the cable out.

¢ Do not plug in or out with wet hands. It may cause
an electric shock.

11
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Basic connections

This projector can be connected to equipment such as VCRs, video cameras, videodisc players, and personal comput-
ers having analog RGB input.

Important:

Make sure that your equipment is turned off before connection.

Match the color of video and audio plugs on the AV cable with each terminal.

Plug in firmly and unplug by holding the plug, not by pulling the cable out.

If connected units are set too close to one another, the image may be affected. Setting connected units too close
to one another affects the image.

e Refer to the owner's guide of each component for details of connections, .

Projector + AV equipment
Make sure that your equipment is turned off before connection.

Important:
S-video signals take priority over video signals. If you input both S-video signals and normal video signals at the
same time, the normal video input automatically shuts off.

Ve !
to audio input 1 >
to video :
N 0, input 1 v
B2 M
s I to audio input 2
I I to S-video Connect either one of these.
input 2

I to video input 2 Projector + DVD player

Some DVD players have output terminal for 3 line fitting (Y, Cs,
Cr). When connecting them to the projector, connect to RGB-1 or
RGB-2 of the projector. In this case, set “Y, C, Cr” for RGB/Y, Cs,
Cr setting in SIGNAL SETTING MENTU.

DVD player

RCA/BNC
adaptor

C

=

to audio to video to audio to S-video to video I

C
I No connection I
=1

....... 8 &L to RGB 1IN
o] 2> or RGB 2 IN

output output output output output
— 1
—F , I— —F —J . . . . .
° - -
VCR, others DVD player, others Use mini D-SUB 15 pin-BNC conversion cable for connection.

e Some DVD player may not project the image correctly.

Cables and adapters
To connect personal computers to this projector, the following cables and adapters are necessary. The overview
might be different from the picture below.

RGB cables (mini D-SUB 15P plug) RGB Conversion adapter for NEC PC (Option)
PO, (mini D-SUB 15P plug - D-SUB 15P plug)

PIN NO.
1

BREAIYS

PIN NO. PIN NO.
e

: <

s s MINID-SUB 15P B [X==E]
c —
£

MINI D-SUB 15P 10
13

MINI D-SUB 15P

PRETTHY
EResw®ann

D-SUB15P

Note: The pins numbered 5, 9, 12 and 15 are not connected.

RGB Conversion adapter for MAC
(mini D-SUB 15P plug - D-SUB 15P plug)

4— 15
SHELL——— SHELL

Note: Set the dip switch to the appropriate position.

Display Resolution Dip switch
mode 1/2]13[4|5 16
13 inch 640 x 480 ON | ON |OFF| OFF| OFF [OFF|
2 == - 16 inch 832 x 624 OFF| ON |OFF| ON [OFF | OFF}
MINI D-SUB 15P D.SUB15P P | 19inch 1024 x 768 OFF| ON | ON |OFF| OFF | OFF
21 inch 1152 x 870 ON|ON| ON| ON|OFF |OFF
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Projector + IBM PC or IBM PC compatibles

Make sure that your equipment is turned off before connection.

Important:

¢ Connectors or analog RGB output adapters may be necessary depending on the personal computer connected to

this projector. Please contact your dealer.

The audio input for a personal computer is the stereo mini-jack. There are some personal computers that have
different types of audio outputs or none at all. Please ask your dealer for details.

For connection details, refer to the owner's guide of each component.

s
n
[t
-
desktop computer %
=
= to AUDIO
] (™ >
=3
= . to PC audio
= | iUt to RGB1 IN
to VGA 1
monitor port

RGB cable

notebook computer

N = ===

to VGA
monitor port

When outputting to both a PC monitor and the projector

desktop computer to RGB OUT
RGB cable
to PC
= moner to AUDIO —
(T >
] md
=
) to PC audio
S PRI to RGB 1IN
to VGA
monitor port

RGB cable

13



ENGLISH

Basic connections (continue)

Projector + Macintosh
Make sure that your equipment is turned off before connection.

Important:

¢ A monitor output adapter is necessary for a Macintosh if it has no video port. Contact your dealer.

e Ifyou use the RGB conversion adapter provided, set the dip switch to the appropriate position. See page 12.

¢ Connectors or analog RGB output adapters may be necessary depending on the personal computer connected to
this projector. Please contact your dealer.

¢ The audio input for a personal computer is the stereo mini jack. There are some personal computers that have
different types of audio outputs or none at all. Please ask your dealer for details.

¢ For connection details, refer to the owner's guide for each component.

¢ When outputting to both a PC monitor and the projector, use an Apple Macintosh monitor or multiscan monitor
corresponding to Composite Sync.

desktop computer

to AUDIO

to PC audio
output

|

‘0

<

to video port

IIEl

1y

n

" RGB Conversion RGB cable
: adapter for MAC
"

n

Power Book

NC ===
to video port

When outputting to both a PC monitor and the projector

Monitor
Conversion

adapter
to PC

monitor [

Monitor cable

to AUDIO

to PC audio
output

to RGB 1IN

to video port

desktop
computer

RGB Conversion RGB cable
adapter for MAC
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Projector + NEC PC-98 series

Make sure that your equipment is turned off before connection.

Important:
[ ]

Connectors or analog RGB output adapters may be necessary depending on the personal computer connected to
this projector. Please contact your dealer.

The audio input for a personal computer is the stereo mini jack. There are some personal computers that have
different type or no audio outputs. Please ask your dealer for details.

For connection details, refer to the owner's guide of each component.

==
0
[t
[
€]
Z
desktop computer =
=== to AUDIO
_mm —
L]
=
s to PC audio
i output
to analog RGB

display connector

notebook computer . m_
: RGB Conversion RGB cable
_ . adapter for NEC
< » PC (option)
\ (uEmmm>»
to analog RGB display
connector

When outputting to both a PC monitor and the projector

Monitor
Conversion
adapter
I = L
to PC 1= . P
monitor Monitor cable

to PC audio
output

to analog RGB
display connector

desktop computer

RGB Conversion RGB cable
adapter for NEC
PC (option)
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To operate projector power ON

Numbers 1 - 9 correspond to the instruction numbers below.

2,9

Left side

+ oo E

&

L 4

4

.

1.

U EEEEEEEEEEEEEEEEEEEER

LAMP TEMP

(@) (@) (@)

CARD 1
(@)

RGB VIDEO CARD MENU

CARD 2
(@)
FOCUS  AUTO
r FINE 7 71— [Z00M POSITION

<

???

@@O@%?

3,7,8 4 4

Put the projector into standby mode by pressing the
main power switch. The POWER indicator lights up
red.

Turn on the equipment connected to the projector.

3. Turn the projector on by pressing the POWER but-

ton.

The light source lamp starts warming up, eventu-

ally turn on. In cases where light source lamp does

not come on, wait for one minute before switching
power on again.

e If power to the main unit is turned off within
two minutes of turning off the light source
lamp, power will not be introduced to the lamp
for one minute the next time the main unit
power switch is turned on. When this happens,
the indicator lamp will blink for one minute.

condition indicator |1 ANfp |POWER
stand-by - red
when light source lamp ison | green | green
when light source lamp does not light up - red
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|
6

5 AUTO position
button

Important:

A darkened image may be seen right after pressing
the POWER button due to warming up of this pro-
jector. When warming up, no other commands can
be accepted.

When the lamp indicator is blinking red, the ser-
vice life of the lamp is about to end. Replace the
lamp. See pages 40 and 44.

The picture might not be of optimum performance
in extreme hot or cold conditions. (The projector is
not malfunctioning.)

Select the desired external input source by using
the RGB or VIDEO button.

The projector automatically selects the appropriate
signal system. The selected signal system is dis-
played on the SIGNAL menu.

When selecting the RGB1 or RGB2 input, the im-
age may be flickered. Press the FINE buttons to
adjust the image.

Press CARD button to see the PC CARD images.
(You cannot select it when CARD 1 or CARD 2 indi-
cator is not lighting up.)



AUTO POSITION button

When the source is selected to RGB1 or RGB2 and

the image is not in the right place, set to display as

blightest signal as possible, then press the AUTO

POSITION button. If the image is still not in the

right place.

e Set screen to the brightest display possible (e.g.,
full-screen display of the “Trash” window) before
deploying the automatic adjustment function.

e Ifthe screen saver is running, turn off the screen
saver before using the automatic adjustment
button.

5. Press the FOCUS/ZOOM button to FOCUS. “FO-
CUS” will appear on the display.

6. Adjust with the /\ or \V buttons on the control
panel (or A or ¥ buttons on the remote control) to
get a fine picture.

e Focus and zoom adjustment by using the buttons on
the control panel or the remote control is possible in
the normal picture mode only. In PinP, EXPAND or
cursor operation mode, the adjustment is impossible.

The volume from the speaker

Press the VOLUME buttons on the remote control to
change the volume from the speaker. You can also
change it by selecting the volume in AUDIO menu.
When setting “ON” for MUTE in AUDIO menu, you
can stop the sound momentary.

¢ The volume button does not work when MENU se-

lecting bar or MENU is displayed.

Turning off the projector

7. Press the POWER button.
The message “POWER OFF? YES : PRESS AGAIN”
appears on the screen.

e To exit from this mode, press any button except
POWER button.

8. Press the POWER button again.
The light source lamp will be turned off.
By pressing the POWER button again, shuts off the
light source lamp, but the exhaust fan continues to
operate for 120 seconds to cool down the light source
lamp and LCD panels. In this time, the lamp indica-
tor will be turned off from flashing.

9. Turn off the main power switch. When turning off
the main switch, the POWER indicator turns off.

¢ In cases where the main power switch is acciden-
tally turned off when either the intake/exhaust
fan or the power source lamp is in operation, allow
the unit to cool down for 10 minutes with the
power turned off. Repeat step 3 when turning on
the power source lamp. If the lamp does not turn
on immediately, repeat this step two or three
times. Replace the lamp if it should still fail to
turn on.

Caution:

¢ When you have finished using this equipment, wait
120 seconds for the exhaust fans to stop. Then turn
off the main switch and unplug the power cable from
the wall outlet, for safety purposes.

e After the lamp is turned off, the lamp cannot be
switched on again for 60 seconds as a precaution-
ary measure. It will take another 60 seconds before
the lamp indicator goes off. If you wish to turn on
the projector again, wait until the indicator is off
then press the POWER button.

e The exhaust fans faster automatically when the tem-
perature around the projector becomes high.

e When the temperature around the projector becomes
much higher, the sign of “TEMP!!” blinks red on the
screen. If the temperature stays in high, the lamp will
be shut off automatically .

The projector automatically shuts off when the
lamp is used up in about 1,300 hours and not used
until lamp replacement.
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Menu operation

Basic operation
Several settings can be adjusted using Menu.

EXAMPLE: Brightness adjustment

1. Press the MENU button.

PinP/ PC CARD
| SIGNAL PICTURE EXPAND AUTO PLAY AUDIO

2. Press the < or > buttons on the control panel (or
<« or P> buttons on the remote control) to select
PICTURE.

PinP/ PC CARD
| SIGNAL PICTURE EXPAND AUTO PLAY AUDIO

3. Press the /\ or \V/ buttons on the control panel (or
A or V¥ buttons on the remote control).

CONTRAST BRIGHTNESS TINT COLOR | coShMMAon
0 0 0 0

B USER m| 1 USER m : ! USER H
L L L L
] 1 1 1
i i i i
v || B | | | ]

PinP/ PC CARD
| SIGNAL PICTURE EXIL’-}\ND AUTO PLAY AUDIO INSTALLATION OPTION

4. Press the < or > buttons on the control panel (or
« or P> buttons on the remote control) to select
BRIGHTNESS.

CONTRAST BRIGHTNESS TINT COLOR | coShMMAon
0 o] 0 0
IlUSER | N USER H N II USER N
L L L L
: : |
-~ | | | | |
| SIGNAL [ PICTURE[  finf AGSARRy AUDIO INSTALLATION ~ OPTION

5. Press the /\ or V' buttons on the control panel (or
A or V¥ buttons on the remote control) to adjust
brightness.

CONTRAST BRIGHTNESS TINT COLOR | coSaMMA N
0 0 0

0 USER ® USER W 1 USER W
i + 1 1
i i i
1 1 1 1
| i i i
v | | | ] | ] | ]

PinP/ PC CARD
| SIGNAL PICTURE EX&’HAND AUTO PLAY AUDIO INSTALLATION OPTION

If you wish to change the color balance, follow
the steps below.

6. Press the < or > buttons on the control panel (or
<« or P buttons on the remote control) to select
USER and press the ENTER button.

BRIGHTNESS
R G B
15 15 15
] 1 1
+ + 4+
1 1 1
b
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. Press the < or > buttons on the control panel (or

<« or P> buttons on the remote control) to select the
desired color R, G or B.

BRIGHTNESS
R B
15 15 15
T
.
v | ] | ] | ]

. Press the /\ or V' buttons on the control panel (or

A or V¥ buttons on the remote control) to adjust
brightness of the desired color.

BRIGHTNESS
R B
15 -15 15
] ] ]
+ 1 4
1 1
mol §f

. Exit the menu system by pressing the MENU but-

ton several times.

If the menu operation is not working, simultaneously
press the MENU and POWER button.

To switch back to the factory preset of each menu,
select RESET and press the ENTER button.

When selecting RESET, the buttons cannot be oper-
ated for 2 to 18 seconds.



]

»

HORIZ. POSITION...
VERT. POSITION
FINE SYNC. .......
TRACKING
RGB/Y, C,, C,

MENU
(G | SIGNAL  PICTURE LY AESARD, AUDIO INSTALLATION ~ OPTION Ver. |
O D D O D O D O
or or or or or or or or
O O IO O O O O O
@ @) ® @ ® ® @ ®
(1) SIGNAL o
)]
AUTO pégﬁ%N p(\g?r{w FINE SYNC. TRACKING | RGB/Y,Cg,Cr E
AUTO a a a a RGB (USER" ™ > @
0 o o o | veer | vovonnm ENTER a O
USER1 A4 v A4 v ISTILL Z
DELETE M €3]
USER2 RESET ™
=
SIGNAL PICTURE exto AGSARRY AUDIO INSTALLATION ~ OPTION Ver. |
AUTO .................. Use to select AUTO, USER 1 or USER 2.

Use to adjust the horizontal position of the image.
Use to adjust the vertical position of the image.
Use to synchronize the projector with PC input signals so that the image is not blurred.

Use to avoid image noise such as wide stripes.

The unit adjusts itself automatically when connected to either DVD players with a
component video output terminal (Y, CB, CR or Y, PB, PR) or equipment with HDTV signal
output capabilities. In cases where the unit is connected to equipment that include an RGB

output terminal and which output HDTV signals, adjust the unit to RGB mode.

(1a SIGNAL - USER (Normally, there is no need for adjustments.)

SIGNAL - USER

CLAMP

CLAMP
POSITION WIDTH

HORIZ.
PIXELS

VERT. VERT
LINES PLL SYNC. HOLD

a -

33
v

-
33

v v

3333 3333
ﬁ[ﬂ

a AUTO
ON

OFF

AUTO

ON — BEGIN END
A a
33 33
v v

AUTO
FAST
NORMAL
SsLow

OFF

CLAMP POSITION/
CLAMP WIDTH

HORIZ. PIXELS ....

If you use a PC video card or something similar, the lighter colors of the projected image
may become blurred. In this case, adjust CLAMP POSITION or CLAMP WIDTH.
Use to adjust the height of the image. The image size grows higher as the number
increases. (Adjust to the horizontal pixels of inputting signal for normal setting.)

VERT. LINES ..... Use to adjust the width of the image. The image size grows wider as the number increases.
(Adjust to the vertical lines of inputting signal for normal setting.)

PLL.....cccovveeee.. Use to adjust the image which upper right side is awry. Select AUTO for normal setting.

VERT. SYNC. ..... Use to adjust the image when its motion does not run naturally. Select AUTO for normal
setting.

HOLD .....ccccovvee. Adjusts the image which upper right side is awry.

@ PICTURE
OCONTRAST OBRIGHTNESS TISIT CO;OR CORRECTION
II USER N | USER N | II USER N
<1 T i
SONAL [PicTURE|  CEBEL. ECOARR AUDIO | INSTALLATION | OPTION ver |

CONTRAST ........ Adjusts the picture contrast. The contrast becomes higher as the number increases.

BRIGHTNESS .... Adjusts image brightness. The image becomes brighter as the number increases.

TINT ..., Adjusts the color balance in the image. The color balance of the image shifts green as the
number increases and shifts to purple as the number decreases (only when NTSC or 4.43
NTSC is selected).

COLOR................. Adjusts the color intensity of the image(only when NTSC, PAL, SECAM or 4.43 NTSC is
selected).

GAMMA

CORRECTION ... Corrects the proportion of the brightness of input signals to that of output signals. Also

corrects the contrast of projected images.
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Menu operation (continue)

(® PinP/EXPAND

This menu appears when either the display enlargement or PinP functions are used.

ZOOM AUTO

MODE. POSITION SIZE PIP.
1 1 % 1 g ON
2 @ § 2 OFF
||
‘ 5
SIGNAL  PICTURE exflo | AGSARy, AUDIO INSTALLATION ~ OPTION Ver. |
Z0OOM MODE ..... Selects the desired type of expand mode, typel, 2, 3 or 4 (Actual size display).
o POSITION .......... Selects the desired position of the sub image in expand or PinP mode.
z SIZE ....ccovvveeennn. Selects the desired size of the sub image in expand or PinP mode.
é AUTO PIP........... Sets to move the position of PinP pictures automatically or not, when it appears on the red
Z frame which shows the PinP part.
@l @ PC CARD AUTO PLAY
SIGNAL  PICTURE exlls | AES ARy AUDIO INSTALLATION ~ OPTION Ver, |
AUTO SLIDE
TIME .......cccceuuuu.... Sets the length of time before the image switches to the next image in PC CARD automatic
playback mode.
REPEAT .............. Sets to repeatedly playback the PC CARD presentation or not in PC CARD automatic
playback mode.
ICON .....cccvveen. Select wether to addition of card icon of PC card. Even the setting is OFF, if you press the PC
card end button on the remote control, the card icon will automatically appear.
& AUDIO
VOLUME MUTE
30
ON
]
SIGNAL PICTURE o MRSARR, M INSTALLATION ~ OPTION Ver. |
VOLUME ............ Adjusts the volume of sound. The volume becomes louder as the number increases.
MUTE.................. Use to set MUTE on or off. Select ON to switch off the sound. Select OFF to switch the sound
back on.
(® INSTALLATION
riveRse  |KEYSTONE| powtkon SIGNAL
ofF  [E] o O ON OFF
MIRROR 3] Z g OFF i
INVERT [ 9“' o 3
e ‘
SIGNAL  PICTURE  fIB( AGSHRRY AUDIO |\NSTALLAT\ON| OPTION Ver. —l
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IMAGE REVERSE Use to reverse or invert the projected image. MIRROR is used for rear projection. INVERT
is effective when the projector is ceiling-mounted.

KEYSTONE ........ Adjusts keystone correction of the image. If the image becomes keystone distortion, select
the approximate setting. For normal use, select 0°. You can use it only when IMAGE
REVERSE is OFF.

AUTO POWER ON ....To select wether to boot up automatically when the power is turned on by a breaker. In this
case, the main power of the projector has to be ON. Set this when the projector is hanging on
the ceiling.

The projector is in stand-by mode when the lamp does not come on. In this case, use the

remote control to turn on the lamp.

TEST SIGNAL.... Use to display the built-in test pattern on the screen.
¢ The display will disappear when the setting is OFF or press the button except MENU,

ZOOM/FOCUS, /\, \V , A ,¥and START/STOP.



@ OPTION

MOTION
JSTILL.

SQUEEZE

MENU
POSITION

MOTION
STILL

4

ON
OFF

1E]
2=l

SIGNAL PICTURE

PinP/
EXPAND

POWER OFE Poaon AL obtpur|LANGUAGE

- AUTO AUTO B

ON — 5 min. NTSC AUTO English

v [ FRONT PAL RGB1 Espafiol

OFF = SECAM RGB2 Deutsch

ﬁ 4.43NTSC Frangais

= PAL-M Italiano

IREAR PAL-N 24

AGSARR, AUDIO INSTALLATION | OPTION | Ver.

MOTION/STILL . Select MOTION when motion images are mainly projected. Select STILL when still images

SQUEEZE

such as PC-CARD images are mainly projected. It works only when inputting personal
computers of SXGA signals or inputting video signal.

Set to switch the normal image (4:3) and HDTV (16:9) automatically or not, depending on the
image signals.

MENU POSITION . Use to select the position where the menu is displayed (top or bottom on the screen).
AUTO POWER OFF .. Use to select the length of time before the projector switches to standby when there is no

input signal selected source. Select OFF to cancel this function.

REMOTE POSITION Select either FRONT or REAR to receive the infrared signal from the remote control. Select

AUTO for normal setting.
Note: When the remote position is changed with AUTO setting, the buttons cannot be
operated for about 3 seconds.

SIGNAL .............. When AUTO is set, the appropriate video standard is automatically selected according to the
input signal. If the image does not appear correctly, select the desired video standard
manually. Adjust the unit to the appropriate format when the unit either is not projecting
normally in auto mode or is inputting PAL-M/PAL-N signals.

RGB OUTPUT .... Use to select the output image from the personal computer terminal (RGB OUT). When
selecting AUTO, the terminal images which signals are input are projected. When a video
signal or PC card is displayed, the unit will project the image sent from the PC input terminal
last displayed.

LANGUAGE ....... Use to select the language for the projector display such as menu.

@ Ver.
|| Ver. 3.3 |
SIGNAL PICTURE Ay AGSRY AUDIO INSTALLATION ~ OPTION | Ver. |_|
Ver. .o, Displays the version of the installed software.
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Picture adjustment

Adjustment from personal computer
Although this projector sets proper signal systems
automatically for the image signal from personal
computers, it cannot be applied to some of personal
computers. In this case, press AUTO POSITION
button. If the images are still not projected correctly,
use MENU display to adjust the projected images
from personal computers. Also available to memorize
the setting.

Adjusting the images form personal

computers in MENU display
Adjust as below for the following symptoms.

AUTO pggﬁ',éN pgsEerN FINE SYNC. | TRACKING | RGB/Y,Cs,Cr

AUTO a a a - RGB USER W
0 0 0 0 Y.Cs,Cr

MEMORIZEE

USER1 v v - v

e \_@
3

DELETEM
RESET H

PinP/
SIGNAL | PICTURE EXPAND

PC CARD
AUTO PLAY AUDIO INSTALLATION OPTION Ver.

Image moves to right or left :

Adjust HORIZ. POSITION in SIGNAL menu. Press
the V' button on the control panel (or ¥ button on
the remote control) to move the image to left. Press
the /\ button on the control panel (or A button on
the remote control) to move the image to right.

Image moves to up or down :

Adjust VERT. POSITION in SIGNAL menu. Press
the V' button on the control panel (or ¥ button on
the remote control) to move the image to upward.
Press the /\ button on the control panel (or A
button on the remote control) to move the image to
down.

Image flickers / Image is out of focus :
Adjust FINE SYNC. in SIGNAL menu.

SIGNAL - USER

CLAMP CLAMP HORIZ.
POSITION WIDTH PIXELS
- - - - AUTO AUTO AUTO

33 33 3333 3333 FAST oN ON — BEGIN END
v v v v NORMAL OFF OFF A a
@ sLow 33 33
v v
. .
Wide stripes appear :

Adjust CLAMP POSITION or CLAMP WIDTH of
each menu in SIGNAL - USER menu.

VERT. VERT.
LINES PLL SYNC. HoLD

Noise etc. appears on right or left side of image:
Adjust HORIZ. PIXELS of the menu in SIGNAL -
USER menu.

Noise etc. appears on top or bottom part of image :
Adjust VERT. LINES of the menu in SIGNAL -
USER menu.

Top part of image curves :
Change the setting of PLL or HOLD of the menu in
SIGNAL - USER menu.
PLL....... Select FAST, NORMAL, or SLOW for
image which top part is the least curved.
Select AUTO for normal setting.
HOLD ...Select ON, and adjust BEGIN or END
for image which top part is the least
curved.
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Image does not move naturally :
Adjust VERT. SYNC. of the menu in SIGNAL - USER
menu. Select AUTO for normal setting.

¢ Do not change each menu setting in SIGNAL -
USER menu for normal setting.

Memorizing the setting

1. Select MEMORIZE in SIGNAL menu, and press
ENTER button.

2. Press the >button on the control panel (or P
button on the remote control).

3. Press the/\ or \Vbuttons on the control panel (or
A or V buttons on the remote control) to select
the memory which you wish to record (USER 1 or
USER 2)

4. Press ENTER button.

Initializing the setting which has been changed

Select DELETE in SIGNAL menu, and press ENTER

button.

e  While INITIALIZING, buttons do not work about
2 - 18 seconds. Use them to operate after initial-
izing is finished.

Seeing images in recorded setting.

Select AUTO in SIGNAL menu, and press the/\ or
\Vbuttons on the control panel (or A or ¥ buttons
on the remote control) to select the memory (USER1
or USER2).

Resetting the recorded setting

1. Select RESET in SIGNAL menu, and press EN-
TER button.

2. Press the >button on the control panel (or P>
button on the remote control).

3. Press the/\ or \/ buttons on the control panel (or
A or V buttons on the remote control) to select
the memory which you wish to reset (USER 1 or
USER 2).

4. Press ENTER button
The recorded setting will be reset.

The simple way of adjustment

1. Horizontal position:
Adjust the start position (the left end) using
HORIZ. POSITION, and adjust the end position
(the right end) using TRACKING. Then repeat
these steps.

2. Vertical position:
Adjust the start position using VERT. POSITION.



Specification of RGB signals in each computer mode of the projector

Signal mode resolution horizontal Vertical Normal Native
(HxV) frequency (kHz) frequency (Hz) (HxV) HxV)
TV60 — 15.73 59.94 1024 x 768 (640 x 480)
TV50 — 15.63 50.00 1024 x 768 (640 x 480)
HiVision - 33.75 60.00 1024 x 576 (882 x 496)
PC98 640 x 400 24.82 56.42 1024 x 640 640 x 400
CGAT70 640 x 400 31.47 70.09 1024 x 640 640 x 400
CGA84 640 x 400 37.86 84.13 1024 x 640 640 x 400
CGAS85 640 x 400 37.86 85.08 1024 x 640 640 x 400
VGAG60 640 x 480 31.47 59.94 1024 x 768 640 x 480
VGAT72 640 x 480 37.86 72.81 1024 x 768 640 x 480
VGAT75 640 x 480 37.50 75.00 1024 x 768 640 x 480
VGAS85 640 x 480 43.27 85.01 1024 x 768 640 x 480
SVGA56 800 x 600 35.16 56.25 1024 x 768 800 x 600
SVGA60 800 x 600 37.88 60.32 1024 x 768 800 x 600
SVGAT2 800 x 600 48.08 72.19 1024 x 768 800 x 600
SVGAT5 800 x 600 46.88 75.00 1024 x 768 800 x 600
SVGAS85 800 x 600 53.67 85.06 1024 x 768 800 x 600
XGA43i 1024 x 768 35.52 86.96 1024 x 768 1024 x 768
XGA60 1024 x 768 48.36 60.00 1024 x 768 1024 x 768
XGAT70 1024 x 768 56.48 70.07 1024 x 768 1024 x 768
XGAT5 1024 x 768 60.02 75.03 1024 x 768 1024 x 768
XGA85 1024 x 768 68.68 85.00 1024 x 768 1024 x 768
SXGAT0a 1152 x 864 63.85 70.01 1024 x 768 1024 x 768
SXGAT5a 1152 x 864 67.50 75.00 1024 x 768 1024 x 768
SXGA85a 1152 x 864 77.49 85.06 1024 x 768 1024 x 768
SXGA60a 1280 x 960 60.00 60.00 1024 x 768 1024 x 768
SXGAT5a 1280 x 960 75.00 75.00 1024 x 768 1024 x 768
SXGA43i 1280 x 1024 46.43 86.87 960 x 768 1024 x 768
SXGA60 1280 x 1024 63.98 60.02 960 x 768 1024 x 768
SXGA75 1280 x 1024 79.88 74.94 960 x 768 1024 x 768
SXGAS85 1280 x 1024 91.15 85.02 960 x 768 — *1
UXGA48i 1600 x 1200 62.50 96.08 1024 x 768 — *1
UXGA60 1600 x 1200 75.00 60.00 1024 x 768 — *]
UXGA65 1600 x 1200 81.25 65.00 1024 x 768 — *1
UXGA70 1600 x 1200 87.50 70.00 1024 x 768 — *1
UXGAT75 1600 x 1200 93.75 75.00 1024 x 768 — *1
UXGA80 1600 x 1200 100.00 80.00 1024 x 768 — *1
UXGAS85 1600 x 1200 106.25 85.00 1024 x 768 — *1
MAC13 640 x 480 35.00 66.67 1024 x 768 640 x 480
MAC16 832 x 624 49.72 74.55 1024 x 768 832 x 624
MAC19 1024 x 768 60.15 74.91 1024 x 768 1024 x 768
MAC21 1152 x 870 68.59 74.96 1024 x 768 1024 x 768
HP75 1024 x 768 62.94 74.92 1024 x 768 1024 x 768
HP72 1280 x 1024 78.13 72.00 960 x 768 1024 x 768
SUNG66a 1152 x 900 61.85 66.00 984 x 768 1024 x 768
SUN76a 1152 x 900 71.81 76.64 984 x 768 1024 x 768
SUNG66 1280 x 1024 71.68 66.68 960 x 768 1024 x 768
SUN76 1280 x 1024 81.13 76.11 960 x 768 1024 x 768
SGI72 1280 x 1024 76.92 72.30 960 x 768 1024 x 768
SGI76 1280 x 1024 82.00 76.00 960 x 768 1024 x 768
IBM60 1280 x 1024 63.42 60.00 960 x 768 1024 x 768
e *1:As aresult of line reduction in the projection Important:

process with the computer models listed above,
lines and portions of characters found in the
original data may be missing from the projected
image.

When the ZOOM MODE of PinP/EXPAND menu is
set to 4, by pressing the EXPAND button on the re-
mote control, it will switch to the screen displaying
the picture as its original size (real screen display).
In the real screen display, pictures will be black-
framed when picture resolution is lower than 1,024
x 768.

e Some computers may not be compatible with the

projector.

The projector's maximum resolution is 1,024 x 768
pixel. It may not be displayed correctly for the pic-
tures of higher resolutions than 1,024 x 768.

The picture with a SYNC on G (Green) signal
may vibrate.

The picture with a SYNC on G (Green) signal may
be tinged with green.
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Picture adjustment (continue)

GAMMA CORRECTION menu

The proportion of the brightness of input signals to that of output signals can be corrected effectively by adjusting

GAMMA.

1. Select GAMMA CORRECTION of PICTURE menu
and then press the ENTER button. (The GAMMA
CORRECTION menu appears on-screen display.)

GAMMA CORRECTION - USER

MASTER =5
R —_— ]
G (e 3 @ 8 B R R R R R EEE BN
. —

Huuw'n =
0 10

Horizontal axis:

20 30 4 5 60 70 80 9 100 RETURN B

brightness of the input signals

If you wish to change the color balance, follow the steps
below.

6. Press the < or > buttons on the control panel (or
« or P> buttons on the remote control) to select
MASTER, and then press the /\ or \V buttons on
the control panel (or A or ¥ buttons on the remote
control) to select the desired color R, G or B.

GAMMA CORRECTION - USER

MASTER =53

Vertical axis:
Inclination:

brightness of the output signals
GAMMA

R
G

0

10

20 3 40 5 60 70

80 90 100

RETURN H

2. Press the < or > buttons on the control panel (or
« or P> buttons on the remote control) to select
MASTER.

GAMMA CORRECTION - USER

R S ——— e

G -
. 7_* -
[Baiuinia}

2 o 10

20 3 40 50 60 70 8 90 100 RETURN B

3. Press the < or > buttons on the control panel (or
<« or P> buttons on the remote control) to select the
points brightness of the input signals.

GAMMA CORRECTION - USER

MASTER] —
R —_— ]
s -
. —am W

[Bainna]

v 0o 10

20 30 4 5 60 70 80 90 100 RETURN B

4. Press the /\ or \V/ buttons on the control panel (or
A or V¥ buttons on the remote control) to adjust
the brightness of the output signals.

GAMMA CORRECTION - USER

20 30 4 5 60 70 80 9 100 RETURN B

5. Repeat steps 3 and 4 for another point setting.
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7. Press the  or > buttons on the control panel (or
<« or > buttons on the remote control) to select the
points brightness of the input signals.

GAMMA CORRECTION - USER

MASTER == == A1

R s § 5 B EREEEI

S -

c ——rHH T

20 30 40 5 60 70 8 90 100

v o 10

RETURN B

8. Press the /\ or V buttons on the control panel (or
A or V¥ buttons on the remote control) to adjust
the brightness of the output signals.

GAMMA CORRECTION - USER

MASTER - =

R I I & B B EHEE

o

v 0 10 20 30 4 50 60 70

80 90 100 RETURN H

9. Repeat steps 7 and 8 for another point setting.
10. Press the ENTER button.

11. Exit the menu system by pressing the MENU but-
ton several times.

e To switch back to the default condition of GAMMA
CORRECTION, select RESET and press the EN-
TER button when the GAMMA CORRECTION dis-
play appears.

¢ When selecting RESET, the buttons cannot be oper-
ated for 2 to 18 seconds.



Advanced feature for presentation

Cursor operation

1.

3.

Move to

Press the CURSOR button.
The cursor appears on the screen.

. Press the START/STOP button to ON.

The operation indicator will be illuminated.
(The operation indicator will turn off if the remote
control is not used for a period of five minutes.)

Move the cursor by using the remote control.

Move to

left right
e T~

Move

Move
downward

Press the START/STOP button to momentarily
freeze the cursor movement. Press again to resume
moving.

. Press the CURSOR button to cause the cursor to

disappear.

When using the EXPAND mode, a red frame will
not appear if the cursor is selected.

To change the cursor size or the cursor moving
speed

1.

Press the CURSOR button.
The cursor appears on the screen.

Press the START/STOP button to ON.
The operation indicator will be illuminated.

. Press the DOUBLE CLICK button.

The tool icon appear on the screen.

% | —

-]

‘ Form
Width
Color

Cursor size

\HHHH\M
|

Cursor speed

. Move the cursor to where the point of cursor size

icon.

Press the SELECT button until the desired size is
appeared.

. Move the cursor to where the point of cursor speed

icon.

Press the SELECT button until the desired speed
is appeared.

\ """"IIIn..

FAST

\lllln... \ "

SLOW

. Press the DOUBLE CLICK button.

To draw line or frame

1.

Press the CURSOR button.
The cursor appears on the screen.

. Press the START/STOP button to ON.

The operation indicator will be illuminated.

Press the DOUBLE CLICK button.
The tool icon appear on the screen.

4. Move the cursor to where the point of form icon.
5. Press the SELECT button until the desired form is

appeared.

@ --------- Rounded-square
|§| ......... Circle

IE' --------- Horizontal straight line

......... Straight line

6. Move the cursor to where the point of Width icon.
7. Press the SELECT button until the desired width

of the line is appeared.

8. Move the cursor to where the point of Color icon.

©

12.

Press the SELECT button until the desired color of
the line is appeared. (Red, Yellow, Green, Blue,
Purple, Black or White)

. Press the DOUBLE CLICK button.
11.

Position the cursor where you want the path to be-

gin and press the SELECT button.

A red frame appears on the screen..

e The red frame will be disappeared by pressing
the CANCEL button.

Move the cursor to where you want the point of the
opposite corner and press the SELECT button again.

By pressing the CANCEL button, the line or frame
will disappear.

When the MENU appears, the cursor will disappear.
When the cursor appears, the source ID will disappear.
You can not adjust the zoom/focus in the cursor op-
eration mode.

When using the EXPAND mode, a red frame will
not appear if the cursor is selected.

The currently projected image will disappear in
the following cases: when PC card images are
updated, when alternating PinP or EXPAND
mode, or when display size is enlarged or
otherwise altered.

Still
How to stop the picture temporaly (still picture)

1.

Press the ENTER/STILL button on the remote
control.
The picture will stop temporaly.

To stop still picture.

2.

Press the ENTER/STILL button on the remote
control again.

To release the still picture, Cursor, SELECT,
DOUBLE CLICK, CANCEL, and START/STOP
buttons also can be used.
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Advanced feature for presentation (Continue)

Super impose (Picture in Picture)

One of the special features of this unit is the picture-
in-picture (PinP) mode. PinP allows you to view differ-
ent sources at the same time. The sub image will be-
come a still picture.

1. Press the PinP button on the remote control.
¢ Pressing the PinP button repeatedly will select
on and off.

2. Select the desired external input source of the sub
image by using the RGB, VIDEO or CARD button.
¢ You can change the frame position and the frame

size by using the on-screen menu.

O 10k
To recapture the picture of sub screen
3 Press the — or + button.

e By each press of the button will recapture the
picture of sub screen.

To switch Main image and sub image
4 Press the < or > buttons on the control panel (or
<« or P buttons on the remote control).

To switch still picture and playback picture between

Main image and Sub image

5 Press the /\ or \V buttons on the control panel
(or A or V¥ buttons on the remote control)

6. Press the PinP button on the remote control.
The sub image will be disappear.

¢ In PinP mode, the sub image will become still
pictures. When the main image is set to PC1 or
PC2, the sub image will become moving pictures.

¢ In PinP mode, the sound of the moving pictures will
be heard.

¢ The sub image may vibrate. If this is the case, select
the image again by pressing the ‘-’ button.

¢ In PinP mode you cannot adjust the zoom/focus.

¢ Ajusting contrast, brightness, tint or color isn't
available in PinP mode.

¢ To use different PC card (PC card 1, PC card 2) on
both Main image and Sub image is not available.

¢ When the main and sub images are set to PC1 or
PC2, images can be selected only from the same
group of the same PC-CARD.

¢ By setting the AUTO PIP on the PinP/EXPAND
menu to ON, the position of the sub image will
move automatically when the red frame indicating
the EXPAND area overlap with the sub image.
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Expand
By pressing the EXPAND button on the remote con-
trol, you can view the detailed image of the picture.

Setting the Expand mode
1. Press the MENU button once to display the on-
screen menu.

2. Press the < or > buttons on the control panel (or

<« or P buttons on the remote control) to select
PinP/EXPAND.

3. Press the /\ or \/ buttons on the control panel (or
A or V buttons on the remote control).

4. Press the < or > buttons on the control panel (or
<« or P buttons on the remote control) to select
ZOOM MODE, POSITION or SIZE.

5. Press the /\ or \V buttons on the control panel (or
A or V¥ buttons on the remote control) to set the
ZOOM MODE, POSITION or SIZE.

ZOOM MODE
(ZOOM MODE1)

T
I Zooming picture
Normal picture

(ZOOM MODE2)

. —Normal
picture

Zooming picture

(ZOOM MODE3) (ZOOM MODE4)
\
\ I
|

Zooming picture

Actual size picture

6. Press the MENU button twice to exit the menu sys-
tem.

Using the Expand mode

1. Press the EXPAND button.
A red frame indicating EXPAND area will appear.

¢ You can magnify different areas of the active pic-
ture by pressing the /\ , \V, < or > buttons on
the control panel (or A, ¥, € or P> buttons on the
remote control).

¢ You can change the magnification of the zoomed
area by pressing the + or - buttons.

2. Press the EXPAND button again.

In EXPAND mode, do not display the test pattern.
In EXPAND mode (except in type 4 mode) you can-
not adjust the zoom/focus.

¢ Display enlargement does not work with video
input or S-video input.

e The red frame indicating EXPAND area will
disappear when the cursor is selected.

Indication Mode 4 (actual size display)

e Pressingthe /\, \V,<, >buttons on the
control panel (or A , ¥ , <, P> buttons on the
remote control) is for adjusting fine adjust, zoom
or focus.

¢ The expanding rate cannnot be changed either
pressing + or - button.



PC-CARD

The projector can play back an image by using the PC-
CARD.

Using the PC-CARD

Use only the flash memory card of PCMCIAeATA com-

patible type II.

¢ Due to PC-CARD type, some images can not be prop-
erly recorded. Please contact your dealer.

Setting up the PC-CARD

1. Set the projector into standby mode by pressing the
main power switch. The POWER indicator lights up
red.

2. Open PC-CARD cover on the left side of the projec-
tor.

3. Make sure the PC card is going to be inserted in
right side. The PC card
indicator of the PC card
which has been inserted
will illuminate.

4. Close the cover.

When the input source is set to

PC1 or PC2, or during recording to the PC card, do not
remove the PC card. The projector may not work cor-
rectly.

Release the PC-CARD

1. Press the RELEASE button on the remote control.
PC card eject icon will be displayed on the right
end of the screen.
The PC card indicator will turned off on the
projector.

2. Open PC-CARD cover on the left side of the projec-
tor.

3. Press the gject button to take the card out.

4. Close the cover.

e Upon removing a PC card, wait at least 2 seconds
before inserting another.

¢ When the input source is set to PC1 or PC2, or
during recording to the PC card, do not remove
the PC card. The projector may not work correctly.

¢ When having an access of PC card, PC card eject
prohibit icon will be displayed on the right end of
the screen.

e Ifyou do not wish this icon to be indicated, turn
ICON on PC CARD menu to OFF. In this case,
the icon appears when the RELEASE button is
pressed even the setting is OFF.

¢ PC card eject icon will be indicated till the card is
ejected. If you press the RELEASE button when
PC cards are inserted, you need to either take
both out or change one of the cards to the icon to
disappear.

e PC-CARD of the following manufacturers has been
confirmed of operation;

EPSON, TDK, Logitec, Panasonic, Verbatim, I-O
DATA.

Play back
1. Insert the prerecorded PC-card.

2. Press the CARD button repeatedly until PC-1 (or
PC-2) appear on the screen.

The PC-CARD index display appears on the screen.

3. Press the < or >buttons on the control panel (or
<« or > buttons on the remote control) to select the
desired image.

e If the PC-CARD is recorded by using the per-
sonal computer, select the desired group by press-
ing the + or - button.

4. Press the /\ or \V/ button on the control panel (or
A or V¥ button on the remote control) to enter the
image display mode.

ENGLISH

5. Press the < or > buttons on the control panel (or
<« or P> buttons on the remote control) to display
another image.

6. Press the VIDEO or RGB buttons to quit the PC-
CARD playback function.

7. Press the RELEASE button on the remote
control.

8. Press the eject button to take the card out.

¢ During PC-CARD playback, the sound is switched
off.

¢ Noise may occur momentarily when images are
updated via PC card.

¢ The images recorded in BMP (not compressed)
will take a long time to playback.

e It takes about 10 seconds to playback JPEG
compressed data.

¢ When having an access of PC card as you want to
exchage images on PC card, there will be four red
line indicated at the edge of the screen.

¢ When the main and sub images are set to PC1 or
PC2, images can be selected only from the same
group of the same PC-CARD. Other group or other
card will not be able to indicate simultaneously.

e Ifthe PC card is ejected when playing back PC
card, the image will be switched to Video 1 picture
automatically.

¢ During PC-CARD playback, if the incorrect
display appears, release and re-insert the PC-
CARD.

Playback picture taken by the digital camera

¢ The image which has been recorded in PCMCIA/
ATA card, smart media or compact flash can be
playback. The PC card adapter is required to
playback smart media and compact flash.

¢ Depending on the type of the digital camera,
picture will not appear correctly. Please contact
your dealer.

e PC card recorded by Digital Camera, the picture
will not be diaplayed on PC-CARD index display.
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PC-CARD (Continue)

To automatically change the image, follow the steps
as shown below.
1. Press the MENU button.

PinP/
EXPAND

PC CARD

SIGNAL AUTO PLAY

PICTURE

Press the < or > buttons on the control panel (or

<« or P> buttons on the remote control) to select PC
CARD AUTO PLAY.

PinP/
EXPAND

PC CARD

SIGNAL AUTO PLAY

PICTURE

10.
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Press the /\ or \V buttons on the control panel (or
A or V buttons on the remote control).

AUTO SLIDE
S REPEAT ICON

-

ON ON
OFF OFF

33 sec.

-
v

INSTALLATION

SIGNAL  PICTURE Piney | PC CARD AUDIO

EXPAND AUTO PLAY]

Press the < or > buttons on the control panel (or

<« or P> buttons on the remote control) to select
AUTO SLIDE TIME.

AVTOPE | REPEAT ICON
-
ON ON
[1asec.
N - OFF OFF
-

SIGNAL  PICTURE Piney | PC CARD AUDIO INSTALLATION

EXPAND AUTO PLAY]

Press the /\ or \V buttons on the control panel (or
A or V¥ buttons on the remote control) to set the
time for auto playback.

AUTO SLIDE
s REPEAT ICON

ON ON
OFF OFF

4

-
[30]sec.
v

INSTALLATION

PinP/ PC CARD
SIGNAL PICTURE EXBAND |AUTO PLAY' AUDIO

. Press the < or > buttons on the control panel (or

<« or P> buttons on the remote control) to select
REPEAT.

AUTO SLIDE
oSt REPEAT ICON

PS

30 sec. ON ON
’ OFF

-
v

PICTURE Finel

SIGNAL EXPAND

PC CARD
|AUTO PLAY AUDIO INSTALLATION

Press the /\ or \V buttons on the control panel (or
A or V¥ buttons on the remote control) to select ON
or OFF.

AUTO SLIDE
e REPEAT ICON
-
oN
30 sec.
N - OFF OFF
v

SIGNAL INSTALLATION

PinP/ PC CARD
PICTURE  gypanD |AUTO PLAY| AUDIO

. Press the MENU button twice to exit the menu sys-

tem.

Press the CARD button repeatedly until PC-1 (or
PC-2) appear on the screen.

Press the < or > buttons on the control panel (or

<« or P> buttons on the remote control) to select the
desired image.

11.

12.

Press the AUTO PLAY button on the remote con-
trol.

The image automatically changes according your
setting.

Press the AUTO PLAY button on the remote con-
trol to quit the PC-CARD automatic playback func-
tion.

A gray frame will appear during auto play.

Button operation will only work when the gray
frame appears on screen. Button operation is not
possible while the red frame is on-screen.

When projecting images in 2-screen display mode,
the screen will momentarily go black when images
inputted via PC card are updated.

Auto play can be stopped by pressing any button
(including SELECT, DOUBLE CLICK, CANCEL,
and START/STOP).

Auto play cannot be used either during image
enlargement or when menus are displayed.



Advanced feature with PC

There are three types of application software provided.

1. PCV (PC Card Viewer)

2. PCGC (Personal Computer Graphic Controller)

3. SpacePointer (Driver for PC control by the remote
controller)

Environment
The following system software and hardware are nec-
essary to use the projector.
When you use Macintosh
e Macintosh series loading more than 68030 in
CPU and a video card with which more than
256 colors are available
e System7.1 or newer
e 8MB of Random-access memory (RAM) space

When you use Microsoft® Windows®

e Microsofte Windowse 95 Operating System
(Windows 95) or Microsofte Windows NTe
Operating System Version 4.0 (Windows NT) or
Microsofte Windowse Operating System
Version 3.1 (Windows 3.1) with the CPU
loading more than 80486SX and a display card
with more than 256 colors are available

e 16MB or more of RAM available

e We recommends the following hardware.
e 32MB or more of RAM available
e A video display card with full colors are

available

EXPORT LAW ASSURANCES

You acknowledge and agree that the SOFTWARE is subject
to restrictions and controls imposed by the United States
Export Administration Act (the “Act”) and the regulations
thereunder. You agree and certify that neither the
SOFTWARE nor any direct product thereof is being or will
be acquired, shipped, transferred or reexported, directly or
indirectly, into any country prohibited by the Act and the
regulations thereunder or will be used for any purpose
prohibited by the same.

LIMITATIONS OF REMEDIES

Regardless of whether any remedy set forth herein fails of
its essential purpose, in no event will Mitsubishi be liable
to you for any special, consequential, indirect or similar
damages, including any lost profits or lost data arising out
of the use or inability to use the SOFTWARE or any data
supplied therewith even if Mitsubishi or anyone else has
been advised of the possibility of such damages, or for any
claim by any other party.

Some states do not allow the limitation or exclusion of
liability for incidental or consequential damages so the
above limitation or exclusion may not apply to you.

In no case shall Mitsubishi’s liability exceed the price for
the SOFTWARE.

A. PCV (PC Card Viewer)

PC-CARD viewer (PCV) is a utility software that lets
you record and project an image to a PC-CARD by us-
ing a personal computer.

Installation of software
For Windows 95 or Windows NT
1. Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Start up Program Manager.
Click the [Start] button and select the [Run (R)] com-
mand. Then the [Run] dialog box is displayed.

4. Ifyou inserted the CD-ROM to drive D, type [D:
Win95\Pcv\Us\Setup95] (Windows 95) or [D:
Winnt40\Pcv\Us\Setupnt] (Windows NT) in the
"command line" text box and click the "OK" button.
The letter [D] may be different according to the
drive you use.

5. When the setup program starts up, follow the on-
screen instructions.

6. When the message “Completed” appears on screen,
click the [Finish] button to complete the installation.

e Installation of Microsoft Internet Explorer 3.02 (or
later) is required for optimum unit operation. Use
the Jaaxdist.exe command should the unit appear
to not be performing normally.

For Windows 3.1
1. Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Select the [Run (R)] command on the icon menu so
that the dialog box [Run] is displayed.

4. If you inserted the CD-ROM to drive D, type
[D:Win31\Pcv\Us\Setup] in the "command line"
text box and click the "OK" button. The letter [D]
may be different according to the drive you use.

5. When the setup program starts up, follow the on-
screen instructions.

6. When the message “completed” appears on screen,
click the [OK] button to complete the installation.

For Macintosh

1. Start up Macintosh.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Copy "PCV for Mac” file in the “PCV” folder to
anywhere on the hard disk.
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Advanced feature with PC (Continue)

Starting up PCV (For Windows)
For Windows 95 or Windows NT

1. Start up Windows.

2. Insert the PC card to the PC Card slot on the per-

sonal computer.

3. Start up Program Manager.
Click the [Start] button and select the [Program
(P)1O0 [Pev]O [PCV]command.

For Windows 3.1
1. Start up Windows.

ENGLISH

sonal computer.

2. Insert the PC card to the PC Card slot on the per-

3. Double click the [PCV] icon in the PCV folder.

Command reference (For Windows 95)
The command references are as shown below:

File
New presentation ....
Open presentation...
Close presentation ...
Save presentation ....

Save presentation As...

Delete presentation .

Image
Add image
Image file... .........
Screen capture... .
Delete image... .........
Image information...
View
Drive Bar..................
Status Bar ................
Window
Cascade ......cccuuuee......
Tile Horizontal .........
Tile Vertical...............

Arrange Icons...........

Windows 1, 2, ... .......
Help
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Create a new presentation.
Opens an existing presenta-
tion.

Closes an opened presenta-
tion.

Saves an opened presentation
using the same name.

Saves an opened presentation
to a specified name.

Delete an opened presenta-
tion.

Exits PCV.

Deletes selected image from
the presentation and moves it
to the clipboard.

Copies selected image data
from the presentation to the
clipboard.

Pastesimage data from the clip-
board into the presentation.

Inserts image file to an opened
presentation.

Captures screen and inserts it
to an opened presentation.
Deletes the selected image
from an opened presentation.
Displays information of the
selected image.

Shows or hides the toolbar.
Shows or hides the drivebar.
Shows or hides the status bar.

Arranges windows in an over-
lapped fashion.

Arranges windows in non-
overlapped horizontal tiles.
Arrages windows in non-over-
lapped vertical tiles.
Arranges icons of closed win-
dows.

Goes to specified window.

Help Topics...............
Advanced settings....

About PCV... .............

Command reference

Offers you an index to topics
on which you can get help.
Displays a detail setting of
this application.

Displays the version informa-
tion of this application.

(For Windows 3.1)

The command references are as shown below:

File
New presentation ....
Open presentation...
Close presentation...

Save presentation... .

Create a new presentation.
Opens an existing presenta-
tion.

Closes an opened presenta-
tion.

Saves an opened presentation
using the same name.

Delete presentation...Delete an opened presentation.

Open image file... .....
Exit .o,
Edit

Tool
Capture ....................

Delete image... .........

View
Tool Bar .....ccuuuen......
Status Bar.................
Option
Select card drive... ...

Card drive info... ......
Index image size... ...

Help
About PCV... .............

Import an image from a file.
Exits PCV.

Deletes selected image from
the presentation and moves it
to the clipboard.

Copies selected image data
from the presentation to the
clipboard.

Pastesimage data from the
clipboard into the presenta-
tion.

Captures screen and inserts it
to an opened presentation.

Deletes the selected image
from an opened presentation.

Shows or hides the toolbar.
Shows or hides the status bar.

Select (or change) the PC-
CARD drive.

Display the information of the
selected PC-CARD drive.
Select the size of index image.

Displays the version informa-
tion of this application.



Recording the image (For Windows)

When you wish to record the image of the display to a

PC-CARD.

1.

Cooose the PC-CARD drive using the drive bar
under the status bar.

File Edit

Image  Wiew  Window

O|2(E]| &2 =

|r=| WoSIs52n (G

[0 ]
i

:I— Drive bar

e Ifyou are using Windows 3.1, select ‘Select card
drive’ in Option menu of PCV main wimdow.

. Choose [New presentation...] under the [File]

menu.
The new presentation window will open.

. Choose [Add image] under the [Image] menu and

then choose [Screen capture...].
e The PCV windows disappear and the capture
dialog box appears.

Return button

Capture setting buttton

Capture button

e Ifyou are using Windows 3.1, select ‘Image
capture...‘ in TOOL of PCV main wimdow.

Display the image you wish to record on the
screen.

. Click the capture button.

The Compress setting window appears.

€ High quality(Low compress)
& Standard

€ Low quality(High compress)

€ Mo compress(BMF format)

File size: 172699 Bytes

I Preserving the setting

. Select the compress type.

¢ You can confirm the compressed image by
clicking the Preview button.

e Ifthe command [Preserving the setting] is
checked , you don’t need to set the style of save
by each images (Not Windows 3.1).

Click OK button.
Repeat steps 4 to 7 for other images.

9.

Click the return button.
The presentation window will open. The recorded
image appears on the presentation window.

g POVD M= E
Eile Edt |magm Y Wirdew Hak

D|S|L] (2w 2% 2]e
- |

Far Help, press F1 Images1 [TKDves

Depending on the personal computer, the recorded
image can appear incorrectly. In this case, set the
delay time longer by using the Capture setting
dialog box.

10. Choose [Save presentation...] under the [File]

menu.
e A presentetion which has been recorded
already, Select “Save As...” to asve as.

11. Choose [Exit] under the [File] menu to quit from

PCV.

When you wish to record the image from existing files.

1.

No

Cooose the PC-CARD drive using the drive bar

under the status bar.

e Ifyou are using Windows 3.1, select ‘Select card
drive’ in Option menu of PCV main wimdow.

Choose [New presentation...] under the [File]
menu.
The new presentation window will open.

Choose [Add image] under the [Image] menu and

then choose [Image file...].

e Ifyou are using Windows 3.1, select ‘Open
image file‘ in File menu of PCV main wimdow.

Select the image you wish to record.

Click OK button.
The recorded image appears on the presentation
window.

The maximum number of group (presentation)
that can be recorded to a PC card is 160.

The maximum number of the images that can be
recorded to a group is 99.

Repeat steps 3 to 5 for other images.

Choose [Save presentation...] under the [File]
menu.

Choose [Exit] under the [File] menu to quit from
PCV.
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Editing the presentation (For Windows)

Delete the image
1. Select the image to be deleted.

2. Choose [Delete image...] under the [File] menu.
e Ifyou are using Windows 3.1, choose [Delete
image] under the [Option] menu.

Sequencing

A. Exchange images

You can exchange the images among images next to
each other.

1. Select an image to be exchanged.

2. Drag the image and drop on the next or previous
image.

B. Move images
You can move images to another position.
1. Select an image to be moved.

2. Drag the image and drop it on the other image
(except next or previous image).
The image will be moved to the previous position
of the dropped image.

1 PCW2
File Edit Image Wiew Window Help

TR E )
[ w5152 ©2 =] E”

For Help, press Ima | =3 [235KBytes 4

. PCWE
File Edit Image Miew Window Help

NECREEEEE )
=l

|f=, WISIs52n ()

Imag=s3 |235KBytes 7
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Preview an image
1. Double click the image.
The preview image appears on the displays.

2. Click the image by using the left button of the
mouse.

Display image information
1. Choose [Image information] under the [Image]
menu.
The image information window appears.
e Ifyou are using Windows 3.1, choose click the
image by using the right button of the mouse.

Numbsr: 0
Farmat typs: JPEG

Compress quality: Standard
File size: 180978 Bytes
Image size: 1024 X 768 Pixels
Image bits: 24 Bits/piel

Image source: Gapture

2. Choose OK to close the image information window.

How to save a file which has been made
by a presentation software (For
Windows 95 only)

1. Make up a presentation by the presentation
software.

2. Choose [Print] under the [File] menu.
3. Set to PCV driver for printing name.

Page Setup HE

Printer
j Properties |

Name: I PCY driver

Status:  Default printer; Ready
Typer  PCV diiver

Where:  nul

Carnmant:

Cancel

e PCV drive will automatically be installed in
the system of the personal computer when PCV
is installed.




4. Click the properties button.

PCV diver Properties HE
Cory |
Bevahtion v
Espand 0 =% 25400
Flefamal:  [JFEG v
JPEG Quall: Mo v
Carcel fol)

5. If necessary, set the Resolution, Expand, File
Format or JPEG Quality.

6. Click OK button on the PCV driver Properties
dialog box.

7. Click OK button.
8. Cooose the PC-CARD drive.

9. Click OK button.

¢ The presentation data will be saved as PCVdrv
on PC card.

e PCVdrv is a temporaly file. If you record
presentation continuously ,The previous data
will be erased. Please follow as below to re-
name the file.

10. Boot up PCV’s programme.

11. Choose [Open presentation...] under the [File]
menu.

12. Select PCVdrv file

The presentation window will openand. The
recorded image appears on the presentation
window.

13. Choose [Save presentation As...] under the [File]
menu.

14. Choose [Exit] under the [File] menu to quit from
PCV.

Starting up PCV (For Macintosh)
1. Start up Macintosh.

2. Insert the PC card to the PC Card slot on the per-

sonal computer.

3. Double click the [PCV for Mac] icon.

Command reference

The command references are as shown below:
File

Create New presentation . Create a new presentation. o
Open presentation... Opens an existing presenta- §<
tion. é
Close presentation ... Closes an opened presenta- b4
tion. &

Save presentation .... Saves an opened presentation
using the same name.
Delete presentation . Delete an opened presenta-

tion.
Open image file... ..... Import an image from a file.
Done ....ccooveevvveeinenns Exits PCV.
Edit

Cut .o, Deletes selected image from
the presentation and moves it
to the clipboard.

COPY vvvveeeeeeeeeeeeeeeinnns Copies selected image data
from the presentation to the
clipboard.

Paste ...cccoveveecneeens Pastesimage data from the
clipboard into the presenta-
tion.

Clear... ...ccccceeeeeeennnns Deletes the selected image
from an opened presentation.

Option
Preference... ............. Select the format BMP or

JPEG.
Get Screen Shot Image .... Captures screen and inserts it
to a presentation.

Recording the image (For Macintosh)

When you wish to record the image of the display to a
PC-CARD.

1.
2.

Display the image you wish to record on the screen.

Press the shift button, command button and
number 3 button simultaneously.

. Repeat steps 1 and 2 for other images.

Choose [GetScreen Shot Image] under the [Op-
tion] menu.

The presentation window will open. The recorded
image appears on the presentation window.

@ File Edit Option Help

EEEIE A E
O————o

GRRl=—"——"—"H

Ho.O
‘ file name: Picture 1
resolution: 1152 x 872pixels

file farmat: PICT

The file type to be recorded are BMP or JPEG. To
change file type, select [Preference] under the
[Option] menu then change setting. Reboot PCV.

Choose [Save presentation...] under the [File] menu.
Choose [Done] under the [File] menu to quit from
PCV.
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When you wish to record the image from existing files.

1. Choose [Create New presentation...] under the
[File] menu.
The new presentation window will open.

2. Choose [Open image file] under the [File] menu.
3. Select the image you wish to record.

4. Click OK button.
The recorded image appears on the presentation
window.

5. Choose [Save presentation...] under the [File]
menu.

6. Choose [Done] under the [File] menu to quit from
PCV.

Editing the presentation (For Macintosh)

Delete the image
1. Select the image to be deleted.

2. Choose [Clear] under the [File] menu.

Sequencing

A. Exchange images

You can exchange the images among images next to
each other.

1. Select an image to be exchanged.

2. Drag the image and drop on the next or previous
image.

*JU o i
‘ file name: Picture 1
resolution: 1152 x 872pixels
file farmat: PICT

file narme: Picture 2
p

resolution: 1152 x 872pixels
file farmat: PICT

Ho.0

- file name: Picture 2

resolution: 1152 x 872pixels
file format: PICT

a1
‘ file name: Picture |
resolution: 1152 x §72pixels

file format: PICT
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B. Move images
You can move images to another position.
1. Select an image to be moved.

2. Drag the image and drop it on the other image
(except next or previous image).
The image will be moved to the previous position
of the dropped image.

m

Ho.0

‘ file name: Picture 1
resolution: 1152 x 872pixels
file format: PICT
Ho.1
- file name: Picture 2
resolution: 1152 x 872pixels
file format: PICT
Ho.2
» file name: Picture 3
- resolution: 1152 x 87Zpixels
file format: PICT
Ma.0 B
- file name: Picture 2

resolution: 1152 = 872pixels
file format: PICT

Ho.1
file name: Picture 3

- resolution: 1152 x 872pixels
file format: PICT

Ho.2
w file name: Picture 1
resolution: 1152 x 87Zpixels

file format: PICT

Preview an image
1. Select an image to be previewed.

2. Double click the image.
The preview image appears on the displays.




B. PCGC (Personal Computer Graphic Control)

By connecting to personal computer is RS-232C port, you can operate your computer with the projector remote
control. Also you can set the menu setting of the projector by computer.

Connection

Projector + IBM PC or IBM PC compatibles (DOS/V)

to RS-232C 1
IN terminal

]

ENGLISH

=]

Ito Coml ﬂﬂ]ﬂ”ﬁ@:g@ﬂmm

Comport RS-232C cable

Note: If your PC (IBM or IBM compatible) is equipped only with a 25-pin serial port connector,
a 25-pin serial port adapter is required. Contact your dealer for details.

Projector + Macintosh

to RS-232C 1
IN terminal

/ to modem port

or printer port
[] /]
S
{compme— (T (=D
RS-232C adapter RS-232C cable
for Macintosh
Note: If the only serial port is a “modem/printer”, use it.

Projector + NEC PC 98 and EPSON series

to RS-232C 1
IN terminal

]

Th

to RS-232C terminal

RS-232C RS-232C cable
adapter for NEC
(option)
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Installation of software
For Windows 95
1. Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Start up Program Manager.
Click the [Start] button and select the [Run (R)] com-
mand. Then the [Run] dialog box is displayed.

4. If you inserted the CD-ROM to drive D, type [D:
Win95\Pcge\Us\Setup] in the "command line" text
box and click the "OK" button. The letter [D] may be
different according to the drive you use.

5. When the setup program starts up, follow the on-
screen instructions.

6. When the message “Completed” appears on screen,
click the [Finish] button to complete the installation.

For Windows 3.1
1. Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Select the [Run (R)] command on the icon menu so
that the dialog box [Run] is displayed.

4. If you inserted the CD-ROM to drive D, type
[D:Win31\Pcgc\Us\Setup] in the "command line"
text box and click the "OK" button. The letter [D]
may be different according to the drive you use.

5. When the setup program starts up, follow the on-
screen instructions.

6. When the message “completed” appears on screen,
click the [OK] button to complete the installation.

For Macintosh

1. Start up Macintosh.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Copy "PCGC” file in the “US” folder of the
“PCGC” folder to anywhere on the hard disk.
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Starting up PCGC
Double click the [PCGC] icon in the setup folder to
start up PCGC.

¢ Do not use SpacePointer during the PCGC opera-
tion.

Note:

e When you operate the PCGC, do not use
SpacePointer.

e Make sure proper connection shave been made, or
else the PCGC will not start up.

e When you operate the PCGC, switch off the menu
display on the projector.
When you operate the PCGC, be sure not to press
any buttons on the control panel on the projector
(except the POWER button).

Caution:

e Mitsubishi is not responsible for any complica-
tions caused by the use of this PCGC software.
For improvement, Mitsubishi reserves the right to
change or alter any or all specification or design of
this remote control and the content of the owner's
guide without any prior notice.

e No part of this software and owner's guide may be
reproduced, transmitted, transcribed, stored in
a retrieval system, or translated into any lan-
guage in any form by any means. Otherwise, this
will be considered as a copyright infringement.



C. SpacePointer

The remote control provides remote PC operation for presentation from PC.
Connection

Projector + IBM PC or IBM PC compatibles (DOS/V)

When connecting two personal computers

RS-232Ccable(option) RS-232C adapter :
for Macintosh to RS-232C:

to Com1 232C;
é)om(;)nolrt 1— d}mnﬂﬁmg —_— Enm__ j2 terminal :

ENGLISH

to RS-232C
to Com1 1 terminal
Comport RS-232C cable
Note: If your PC (IBM or IBM compatible) is equipped only with a 25-pin serial port connector,

a 25-pin serial port adapter is required. Contact your dealer for details.
Projector + Macintosh

When connecting two personal computers

I

Printer cable for Macintosh (option) ;0 RS'232ICi

terminal |

—_— — !

||’~

to modem port

|
— |
== ] @// or printer port |
(] !
2 i —
_____________________________________ |
l. ¥ to RS-232C
o=@ [}« (E=C 3 HI— 1 termina
to modem port RS-232C adapter RS-232C cable
or printer port for Macintosh
Note: If the only serial port is a “modem/printer”, use it.

Projector + NEC PC 98 series

When connecting two personal computers

e = e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e s - — - -

RS-232C adapter !
for NEC (option) RS-232C cable (option) RS-232C adapter I

|

i

[ for Macintosh  to RS-232C!
|

: to RS-232C
Itermlnal I
|

|

|

|

|

|

«ﬂ}ﬂﬂ”ﬂmﬂﬂ@ﬂmﬂmﬂ[@» inm__ 2tejrminal i

to RS-232C

l 1 1 terminal
to RS-232C terminal - G}HHH”MD:CP

RS-232C cable

RS-232C adapter
for NEC (option)
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Installation of software
For Windows 95

1.
2.

Start up Windows.

Insert the Projector driver CD-ROM into your CD-
ROM drive.

. Start up Program Manager.

Click the [Start] button and select the [Run (R)] com-
mand. Then the [Run] dialog box is displayed.

If you inserted the CD-ROM to drive D, type [D:
Win95\Sp\Setup] in the "command line" text box
and click the "OK" button. The letter [D] may be
different according to the drive you use.

When the setup program starts up, follow the on-
screen instructions.

When the message “Completed” appears on screen,
click the [Finish] button to complete the installation.

For Windows 3.1

1.
2.

Start up Windows.

Insert the Projector driver CD-ROM into your CD-
ROM drive.

Select the [Run (R)] command on the icon menu so
that the dialog box [Run] is displayed.

If you inserted the CD-ROM to drive D, type
[D:Win31\Sp\install] in the "command line" text
box and click the "OK" button. The letter [D] may
be different according to the drive you use.

Select the [Installation (I)] commandon the instal-
lation menu.

When the setup program starts up, follow the on-
screen instructions.

When the message “completed” appears on screen,
click the [OK] button to complete the installation.

For Macintosh

1.
2.
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Start up Macintosh.

Insert the Projector driver CD-ROM into your CD-
ROM drive.

Copy "Alps RSSPointer" file in the “US” folder of
the “SpacePointer” folder to the system folder.

Restart the Macintosh.

Operation of PC by remote control
The remote control provides remote PC operation for
presentation from PC.

1.
2.

Press the RGB button to select RGB1 or RGB2.

Press the START/STOP button to ON.
The operation indicator will be illuminated.

Confirm that the cursor of the projector does not
appear on the screen. If the cursor does appear, press
the CURSOR button to OFF.

You can use the SELECT, CANCEL and DOUBLE
CLICK button in the same way as the button on the
mouse. You can also move the cursor of PC by using
the remote control. For cursor moving, see page 25.

Press the START/STOP button to exit from PC
control mode.

Depending on the personal computer, SpacePointer
may not work after leaving from the suspended
mode. In this case, click the Apply button on the
control panel. See below.

Setting of SpacePointer
For Windows
You can set the several settings in the SpacePointer

co
.

ntrol panel in the control panel folder.
Mouse cursor size and color cannot be adjusted in
the Windows 3.1.

Enable/Disable

‘SpacePoiner

SpacePointer’

For normal use set to Enable. If
you do not use SpacePointer, set

to Disable.

[

Enable/Disable

© Enable 0 Disable.

ConnectPort © COM1 © COM2 © COM3 O COM4

Port selection

stow

HEHEHEHH

FAST

Used to select the port connected
to the projector.

-

Tracking speed

If you click Fast, the cursor

Change cursor !

moves more than twice as fast
as you move the space pointer.
When you first try the remote
control, set it to slow.

Size/color
Changes the size and color of the
mouse cursor.

For Macintosh
You can set the several settings in the Alps RSSPointer
control panel in the control panel folder.

]

Alps RSSPointer="== B

ALPS SpacePointer

Moni

Monitor size

tor Size | Port

) @W [(Modem | Port selection
Used to select the port connected
e o @ to the projector.
o ot Help
x| [x] [ % Tracking speed
K| K L L L
D If you click Fast, the cursor

moves more than twice as fast

as you move the space pointer.
When you first try the remote
control, set it to slow.



Uninstallation of software
For Windows 95

1.
2.

Start up Windows.

Insert the Projector driver CD-ROM into your CD-
ROM drive.

Start up Program Manager.
Click the [Start] button and select the [Run (R)] com-
mand. Then the [Run] dialog box is displayed.

If you inserted the CD-ROM to drive D, type [D:
Win95\Sp\Spuninst] in the "command line" text
box and click the "OK" button. The letter [D] may be
different according to the drive you use.

. When the installation program starts up, follow the

on-screen instructions.

When the message “Completed” appears on screen,
click the [Finish] button to complete the installation.

If you use the Windows 3.1

1. Start up Windows.

2. Insert the Projector driver CD-ROM into your CD-
ROM drive.

3. Select the [Run (R)] command on the icon menu so
that the dialog box [Run] is displayed.

4. If you inserted the CD-ROM to drive D, type
[D:Win31\Sp\install] in the "command line" text
box and click the "OK" button. The letter [D] may
be different according to the drive you use.

5. Select the [Uninstallation (U)] commandon the in-
stallation menu.

6. When the setup program starts up, follow the on-
screen instructions.

7. When the message “completed” appears on screen,
click the [OK] button to complete the uninstallation.

For Macintosh

1. Start up Macintosh.

2. Move "Alps RSSPointer" in the control panel folder
in the system folder to “Trash”.

3. Restart the Macintosh.
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Replacement of a light source lamp

The light source lamp is designed to project the image

on

the LCD panel. When the light source lamp no longer

functions, replace it with a new one to ensure optimum
performance.

Caution:

Do not remove the light source lamp from inside of
this equipment immediately after using the projec-
tor, you may get burned because of the high tem-
perature of the light source lamp.

When you replace the light source lamp, press the
power button to power off, then wait for 120 sec-
onds in stand-by mode to cool down the lamp and
LCD panels. Turn off the main switch, unplug the
power code from the outlet and wait one hour so
that the lamp is cool to the touch.

Do not remove the light source lamp except for re-
placement. Careless treatment can cause injury or
fire.

Do not touch the lamp directly. It may be broken
and may cause you to injure or burn yourself.

Be sure not to drop the lamp lid screw into the pro-
jector. Also be sure also not to insert metal or any
flammable objects, it may cause fire or an electric
shock. If any objects are inserted, please unplug and
contact your dealer.

Install the lamp securely, failure to do so it may
cause a fire.

Loosen the screw of
the lamp lid on the
top cover using a
screwdriver (+) , and
remove the lid.
Remove the lamp
cover in the direc-
tion of the arrow as
indicated.

Loosen here

Important:
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Be careful not to damage the electric wire connected
to this equipment.

Loosen a screw (a) of fix-
ing metal using a screw-
driver (+), and remove
them.

Do not lose the fixing
metal and screws.

(@ Fixing
metal

H—(e)

3.

10.

. Insert the new lamp securely

. Remove the holes from the

Set Lamp exchanging metal into the projector.

1) Insert metal fittings for lamp replacement in
the following positions: on the front face of the
lamp (2 positions), between the lamp, and on
the bottom edges (4 positions).

2) Align screw holes (¢) with node (d).

3) Fasten the piece into place using the two
screws included (b, b’).

&
-

. Loosen the lamp fixing screw (e) using a screwdriver

(+), and remove it.

. Hold onto the projector

by the handle as you pull
out the lamp.

For the lamp you have
removed, do not spill lig-
uid on it, place it near
flammable objects or
where children can touch
it. Otherwise, it will cause in-
jury or fire.

into the projector body in the
right direction.

Tight up the screws (e) which
have been removed in 4 using a screwdriver (+).

Loosen the two screws (f), (f')
of lamp exchanging metal
using a screwdriver, and re-
move them with the metal.

(e

lamp replacement metal
fittings (c) from the node
(d).

Insert the fixed metal pieces
from step 2 into the screw
holes (f) and (f”), and use one
screw (a) to hold the piece in
place.




11. Tighten up the screw of )
the lamp lid using a
screwdriver (+).

How to reset the operation time meter

Plug in the power cord, switch on the projector and re-
set lamp time by pressing the <, > and POWER but-
tons simultaneously.

e Lamp cannot be removed from the projector unless
setting the lamp exchanging metal.

e Ifyou do not have the lamp exchanging metal, re-
move the metal from the new lamp and use it. Do
not touch the lamp directly. It may be broken and
may cause you to injure or burn or yourself.

Caution:

¢ For the lamp you have removed, do not spill liquid
on it, place it near flammable objects or where chil-
dren can touch it. Otherwise, it will cause injury or
fire.

¢ Be sure that the projector guide is firmly inserted
between the right and left lamp guides.
Do not touch the lamp directly, place a cloth over
the replacement lamp.

Important:

¢ The projector will not turn on if you do not secure
the lamp lid.

¢ The operation time meter must be reset after the
lamp has been replaced.

¢ Do not reset the operation time meter unless the
lamp has been replaced.

The life of the lamp

The average life of the lamp for the projector is about
1,000 hours of consecutive use. Life span may differ
according to operating environment, and may be shorter
than 1000 hours. Decreases in luminescence and/or
color brightness will indicate that the light source lamp
is in need of replacement. When lamp operation time
exceeds 1,000 hours, the indicator will flash alternately
between green and red (while the lamp is in operation;
when the lamp is not in operation, the indicator will
appear red only). When the lamp has been used for
about 1,250 hours, the message “LAMP!!.” will appear
on the screen. When the lamp has been used for about
1,300 hours, the projector will automatically shut off
for the safety of the lamp and the power indicator light
up in red. The projector cannot be used until the lamp
has been replaced.

Caution:

e The light source lamp is fragile. Be careful not to
cut yourself with the fragments.

e The lamp life depends on the environment. For re-
placement lamps, please contact your dealer.

The projector automatically shuts off when
the lamp is used up in about 1,300 hours
and not used until lamp replacement.
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Maintenance

Caution:

Be sure to turn off the projector and unplug the power
cord from the wall outlet before you perform any main-
tenance on the projector.

Cleaning the air-filter

Clean the air-filter frequently. If the filter or ventila-
tion slots become clogged with dirt or dust, the tem-
perature inside of the projector may rise and shut of
the power (the thermal indicator starts to blink red).

1. Press and raise the air-filter cover with a screwdriver

).

® O
L]
Lo
CICICIE ]
HEF 1N
[l [l
B imn
t 1t |

L

2. Wash the air-filter.
Use water or a mild detergent diluted with water to
clean the filter. Rinse the filter thoroughly and let it
dry completely. If the filter is damaged or becomes
extremely dirty, contact your dealer for replacement
information.

3. Attach the air filter to the cover.

FILTER

FILTER COVER

4. Reinstall the air-filter cover.

Note: The power will not turn on if the air-filter cover
is improperly installed.
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Caution:

Be sure to use the projector with an air-filter. If not,
dust may get inside the projector, causing a fire or a
breakdown.

Cleaning the projector and the ventilation
slots

Use a soft cloth to clean the projector and the ventila-
tion slots. When the slots become dirty, wipe them with
a soft cloth dampened with a diluted mild detergent,
and then wipe them with a dry cloth.

To protect the surface of the projector from fading or
deteriorating:

¢ Do not spray insecticide on or inside the
projector.

¢ Do not use benzine or thinner to clean it.

¢ Do not let rubber or plastic materials come into
contact with the projector.

Cleaning the lens

Use a standard lens-cleaning brush or a piece of lens
tissue dampened with lens cleaning fluid. The lens sur-
face is fragile. Use only recommended, nonabrasive
lens-cleaning materials. Do not touch the lens with your
fingers.



Troubleshooting

The following offers solutions to some of the common problems you may encounter. We suggest that you consult
this chart before contacting your dealer.

PROBLEMS CAUSE POSSIBLE SOLUTIONS
e The air intake vents, exhaust vents or air filter | ¢ Remove the object.
is clogged with dust or some object.
Power indicator does not light up.
e Power cord is unplugged from the outlet. e Plug the power cord into the outlet.
e Power cord is disconnected from the projector. ¢ Insert the power cord into the projector.
e The main switch is turned off. e Turn the main switch on.
e The lamp lid is open. e Close the lamp lid.
Power indicator blinks red.
. e The projector has been turned on again too soon | e Wait for the lighting sequence.
The power is off. after having been turned off.

e When the power switch was turned off while
the fan was running, during or after lamp
operation.

¢ The room temperature is too high.

(Does the lamp indicator show an unusual
condition?)

e Lamp is no longer working.

Power indicator blinks between red and green.

e The filter cover is not closed.

e When the power source lamp indicator or the
temperature indicator is either on or blinking,
the main unit requires repairs.

e Turn the power switch on and off several times.

e Refer to "Indicators" on page 44.

e Replace the lamp with a new one.

e Close the cover correctly.
e Contact your dealer.

No picture appears
on the screen.

e Lens is covered by lens cap.

¢ When the power source lamp indicator or the
temperature indicator is either on or blinking,
the main unit requires repairs.

e The equipment connected to this projector is not
turned on.

o Hookup is not made correctly with other equipment.

e The input source is not selected correctly.

e Take the lens cap off.
e Replace the lamp with a new one.

e Turn on the connected equipment.

e Confirm the hookup.
e Select the correct source according to the equip-
ment connected to this projector.

The image is
distorted.

o The projector is not at a right angle to the screen.

e Adjust the angle of the projector to make a right
angle to the screen. See page 11.

The image is dark.

e Brightness, tint and color are not adjusted cor-
rectly.

e Adjust brightness, tint and color correctly.

The image is
blurred.

o The projecting distance is beyond the focused area.

e Lens is dirty.

¢ Screen size exceeds screen size specifications.

e Brightness, contrast and DLE are not adjusted
correctly.

¢ FINE adjustment is not made correctly.

¢ Tracking is not adjusted.

¢ The projector is not at a right angle to the screen.

e Adjust the projecting distance. See page 10.
e Clean lens.

¢ Reduce screen size to within 40" to 300".
e Adjust brightness, contrast.

e Make FINE adjustment.

¢ Adjust tracking.

e Adjust the angle of the projector to make a
right angle to the screen. See page 11.

The image remains
blurred.

e When you see the stationary image for a long time, it may remain on the screen if you change the
image. It is not a breakdown. The blurred image will disappear in a few minutes.

Red, blue or green dots|
are viewed on the text of]
image.

e It is normal.

The image is
distorted on the
screen and noise is
heard.

e The cable for connection with other equipment
is not plugged securely into the terminal.

o The projector is installed too close to other
equipment.

e Plug the connecting cable securely into the
terminal. See pages 12-15.

e Install the projector far away from other
equipment.

No sound is heard.

e Volume is not turned up.

e Mute function on PCGC is on.

e Connection to other equipment is not made
correctly.

e Turn up the volume.
e Cancel the mute function. See page 20.
¢ Check connections.

See pages 12-15.

Nothing is displayed on
the PC monitor.

e The PC monitor is not turned on.

e Turn on the monitor.

Warm air comes out of
the exhaust vents.

e This is typical of the LCD projector.

Adjustments cannot be

made.

e The operation is incorrectly made due to noise or
interference.

e Press the MENU and POWER buttons simulta-

neously. See page 18.

43

ENGLISH



ENGLISH

Indicators

The projector has three indicators each of which shows the working condition of the projector.

The following offers solutions to possible problems. If a problem persists, turn the projector off and consult your

dealer.

14

LAMP TEMP
O O O - =-=="
0) RGB  VIDEO
INDICATOR SHOWS CONDITION POSSIBLE SOLUTIONS
¢ Unusual temperature
The power is turned off
and the POWER indicator
lights up red.
* The ventilation slots or air | e Remove the object from
filter is clogged with dust the ventilation slot.
TEMP or debris.
blinking red |® The fan has stopped due e Pull out the power
INDICATOR 8 to an impediment. plug and remove the
object. If you cannot,
. consult your dealer.
* The location temperature ¢ Relocate the projector
is too high. to a cooler place.
e The filter is dirty. ¢ Clean the filter.
Steady green | Normal -
Blinking red/green | Lamp is almost used up.
LAMP or Blinking red Replace the lamp.
INDICATOR e Lamp is used up Exchange with a new
Steady red ’ lamp if the same
e The power is not turned on. | Problem recurs.
(Power indicator lights up red.)
Steady red | Standby -
Steady green | Power-on -
POWER ® The filter cover is not closed. | ® Close the cover cor-
INDICATOR | Blinking red/green |~ (When the TEMP indicator and |  rectly.
or Blinking red the LAMP indicator are off.)
® Abnormal ¢ Contact your dealer.
(When the TEMP indicator
or the LAMP indicator

steady on or blinking.)




Specifications

Type LCD projector

Model LVP-X200A

Rated power supply | AC100 ~ 240V, 50/ 60Hz

Rated input 5.0A

LCD panels 1.3-inch LCD panel: 3 pieces (for R, G, B)

Pixels 1,024 x 768 = 786,432 pixels
Total 2,359,296 pixels
Active pixel rate: 99.99 % or more (each panel)

Projection lens

F23~27 f{=533~69.3mm

Light source lamp

330 W DC metal halide lamp

Picture size

aspect ratio 4:3 40~300 inch

Audio output

1 W+ 1 W stereo

Speakers

6 cm round type (8Q 1W) x 2 pcs.

S-video input

Luminance signal: 1.0 Vp-p 75Q (negative sync.)
Chroma signal: 0.286 Vp-p 75Q (burst signal)

Video input

1.0 Vp-p 75Q (negative sync.)

(mini D-SUB 15P)

Audio inputs 350 mVrms, 10kQ or more
. RGB: 0.7Vp-p 75Q (positive sync.)
Analog RGB input YCsCr: Y:1.0Vp-p (negative sync.) CsCr:0.7Vp-p

HD/CS : TTL level (positive)
VD : TTL level (positive)

PC audio inputs

350 mVrms, 10kQ or more ¢3.5mm stereo mini jack

Control connector

Serial (D-DUB 9 pin male connector) RS-232C standards
Serial (Mini DIN 8 pin female connector) RS-232C standards

Outside dimensions

330 x 145 x 398 mm

: . Legs and lenses are not included.
(width x height x depth)

Weight

21.51b (9.8kg)

Length of power code

114 inch (2.9m)

Temperature, humidity
(performance guarantee)

+41°F (+5°C) ~ +95°F (+35°C), 30~90%

Replacement parts list
What’s included in the box

1 AC power cable 246C346-10
1 RCA video cable 246C323-10
1 RCA/BNC adaptor 452D173-10
1 Audio cable 242C938-10
1 RGB cable for PC 246C318-10
1 MAC adaptor for RGB cable 246C319-20
1 RS-232C cable 246C320-10
1 MAC adaptor for RS-232C cable 246C321-10

Remote control
Warranty card
User’s manual
Software (CD-ROM)
2 Battery for remote

R e

Accessories

1 Spare metal halide lamp
1 PC audio cable

939P746-10
854B311-10
871D237-50
919P095-10

499B012-10
242D493-10

45

ENGLISH



